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Introduction 

We thank you for using the e-Parcel Secure Data Delivery Service - Enterprise – Software. 

 

 

 e-Parcel ID Sharing function Operation Guide 

At the beginning of the introduction to the new function “ID Sharing” which the e-Parcel VCN-AX 

5.0 as a host can be interlocked with the e-Parcel VCN-CommCenter 8.0 as clients, this Operation 

Guide will briefly instruct you on usage about installing and configuring applications in order for the 

“ID Sharing” function to work. 

 

 

 Product Concept of e-Parcel VCN-AX 5.0 

The e-Parcel VCN-AX 5.0 (Auto eXchange) of our product is designed for the secure automated 

data transfer between company's systems. Also, various API are available for the application 

integration to implement into customer's server and EDI. 

The automated, authenticated, encrypted secure data transfer functions facilitate the process. 
*The e-Parcel VCN-AX 5.0 have been released apart from VCN-AX 4.0 as automation client software for 

large-scale and high-load use. 

 

 

 Product Concept of e-Parcel VCN-CommCenter 8.0 

The e-Parcel VCN-CommCenter 8.0 of e-Parcel Secure Data Delivery Service - Enterprise – Software 

is developed for the product concept of digital data delivery service to deliver large-volume and 

confidential digital data easily, safely, securely via the Internet by just installing client software 

based on the newly-developed next-generation data delivery engine for enterprise users at high 

quality and security level. The data includes three-dimensional CAD/CAE, design/technical data, 

software source code and highly confidential data such as customer's personal information. 

The e-Parcel VCN-CommCenter 8.0 are the standard client software for e-Parcel Secure Data 

Delivery Service. 

Just install a client digital certificate and software are given in your PC! Only with this operation, 

you can easily start e-Parcel secure data delivery service with other e-Parcel clients via the Internet. 

The e-Parcel client software operation is just as simple as e-mailing. It allows you to send and 

receive large-volume and confidential digital data easily, safely, securely. 
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About ID Sharing function 

What’s ID Sharing function? 

According to the new function “ID Sharing”, an e-parcel ID set up to the e-Parcel VCN-AX 5.0 can be 

interlocked with the multiple e-Parcel VCN-CommCenter 8.0. 
*The e-Parcel VCN-AX 5.0 and the e-Parcel VCN-CommCenter 8.0 provide the “ID Sharing” function. 

 

Usually, in order to maintain high security level (Authentication), the e-Parcel secure data delivery 

service has adopted the digital certificate based on X.509 on both the server and a client. Therefore, 

the e-Parcel service must disallow duplicate client software installation by the same e-Parcel ID (the 

same e-Parcel client digital certificate) in multiple computers. 

 

However, using the “ID Sharing” function, the e-Parcel ID set up to VCN-AX 5.0 can be 

shared with multiple VCN-CommCenter 8.0 in which users register ID sharing with high 

security level as well. Also, the histories recorded in outbox and inbox can be shared with VCN-AX 5.0 

and all of VCN-CommCenter 8.0 which have been configured to “Register ID sharing”. 

 

The following descriptions in this guide will instruct you to configure and use the “ID Sharing” 

function. 
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Terms of ID Sharing function 

To smoothly start ID Sharing function, please carefully read the terms described below for your 

understanding in advance. 

 

【ID Sharing Host PC】 

For use in the “ID Sharing” function, you can set up a sharing e-Parcel ID (client digital certificate) 

to VCN-AX 5.0 in one computer only. 

(A computer in which you install the e-Parcel client software VCN-AX 5.0 and set up a sharing 

e-Parcel ID, hereinafter referred to as “ID Sharing Host PC”) 

 

【ID Sharing Client PC】 

The operation “Register ID Sharing” is available to multiple VCN-CommCenter 8.0. 

(Computers in which you install the e-Parcel client software VCN-CommCenter 8.0 and register ID 

sharing, hereinafter referred to as “ID Sharing Client PC”) 

 

In addition, in the VCN-CommCenter 8.0 ID Sharing Client PC, the operation “Register ID Sharing” 

is NOT required installing the e-Parcel client digital certificate of Sharing ID. 

 

【Private ID & Sharing ID / Private Mode & ID Sharing Mode】 

For new users, install VCN-CommCenter 8.0 and operate to “Register ID Sharing”. You can set up 

only Sharing ID to the VCN-CommCenter GUI and use in ID Sharing Mode. 

 

Or, for the existing users of VCN-CommCenter 8.0, just operate to “Register ID Sharing” on the 

VCN-CommCenter GUI. You can set up both Private ID and Sharing ID to one 

VCN-CommCenter GUI, and then run the application both in Private Mode and in ID Sharing 

Mode. 

 

【What’s Private ID?】 *One ID is available to one PC only as usual. 
Normal e-Parcel ID set up to VCN-CommCenter 8.0 

(Private Mode: in the case of running the e-Parcel client software with Private ID) 

 

【What’s Sharing ID?】 *Register ID Sharing is available to multiple client PC. 

e-Parcel ID set up to VCN-AX 5.0 which is shared with VCN-CommCenter 8.0 

(ID Sharing Mode: in the case of running the e-Parcel client software with Sharing ID)
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Image of ID Sharing function 

 

 

 

 e-Parcel VCN-AX 5.0 (ID Sharing Host PC) 

[For example: e-Parcel ID: abcd123@ep.co.jp] 

 

 

 

 

 e-Parcel clients 

 

     

 e-Parcel VCN-CommCenter 8.0 (ID Sharing Client PC) 
*Register ID Sharing is available to multiple client PC. 

[For example: Sharing ID: abcd123@ep.co.jp] 

 

 

 

 

 

[Communications are available to] 
the e-Parcel 

VCN-AX 4.0 or later 
VCN-CommCenter 7.0 or later 

VCN-Web 

Internet 

Upload and Download files/folders 
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System Requirements 

e-Parcel VCN-AX 5.0 (ID Sharing Host PC) 

The section below describes the system specifications for the e-Parcel VCN-AX 5.0 in the ID Sharing 

Host PC. (*ID Sharing Host is available to one PC only.) 

Software Name  e-Parcel VCN-AX 5.0 

Operating System 

Microsoft Windows  

XP or later / Server 2003 or later 

32bit or 64bit 
Available display languages are listed below for VCN-AX: 
  [Japanese, English] 
 
Linux 

Red Hat Enterprise Linux (or compatible OS) 6 or later 

32bit or 64bit 
*VCN-AX 5.0 are compatible with Linux. 

Network 

Internet Connection to the e-Parcel servers 
*If your computer or network environment (the proxy server, 

firewall, any applications for security measures or etc.) 
have any access control such as block or analysis of SSL 
connections, you need to allow (exclude from target) 
HTTPS protocol communications [Port=443] to the e-Parcel 
service domains as of [https://*.e-parcel.ne.jp] and 
[https://*.e-parcel.com] (Wildcard domain: Asterisk 
mark [*] would be replaced with name of multiple servers 
via the e-Parcel service.). 

Computer Memory (RAM) 64 MB RAM or more for application 

Disk Space 
30 MB Disk Space or more for installation 
*Plus, additional disk space required for delivery items while 

sending and receiving. 

Recommended 

*To use efficiently, recommend near the latest version of OS 
and browser application, computer memory and disk space 
as much as possible. 

 
*If introducing cluster constitution using WSFC (Windows 

Server Failover Cluster) etc., please contact the e-Parcel 
Customer Support by e-mail (support@e-parcel.co.jp) with 
your e-Parcel ID specified. 
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e-Parcel VCN-CommCenter 8.0 (ID Sharing Client PC) 

The section below describes the system specifications for the e-Parcel VCN-CommCenter 8.0 in the 

ID Sharing Client PC. (*Register ID Sharing is available to multiple client PC.) 

 

Software Name  e-Parcel VCN-CommCenter 8.0 

Operating System 

Microsoft Windows  

XP or later / 2000 Server or later 

32bit or 64bit 

 
*Available display languages are listed below 

for VCN-CommCenter GUI: 
[Japanese, English, French, German, Spanish, 
Chinese-simplified, Chinese-traditional] 

Network 
For use in the “ID Sharing” function: 

Connection to the VCN-AX 5.0 ID Sharing Host PC 

Computer Memory (RAM) 64 MB RAM or more for application 

Disk Space 
15 MB Disk Space or more for installation 
*Plus, additional disk space required for delivery items while 

sending and receiving. 
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Advance preparations 

You are required to install the following e-Parcel client software which provide the “ID Sharing” 

function. 

 

Required software version for ID Sharing function 

 

 

【For ID Sharing Host PC】 *available to one host PC only 

 

 

 e-Parcel VCN-AX 5.0.5011 or later 
 

 

 

 

【For ID Sharing Client PC】 *available to multiple client PC 

 

 

 e-Parcel VCN-CommCenter 8.0.8021 or later 
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Advance preparations for starting ID Sharing function 

 

【ID Sharing Host PC】 

１．Preparations for e-Parcel VCN-AX 5.0 ⇒ Refer to P11 

Install both e-Parcel client digital certificate and software VCN-AX5.0. 
(*ID Sharing Host is available to one PC only.) 
 
First, prepare in the ID Sharing Host PC. 

As usual, import the e-Parcel client digital certificate of a sharing e-Parcel ID, install the client 

software VCN-AX5.0 and auto setup in just one PC. 
 
*You may need the additional configurations such as remote access to VCN-AX 5.0 and connections 

through Windows Firewall to allow. 

 

 

 

【ID Sharing Client PC】 

２．Preparations for e-Parcel VCN-CommCenter 8.0 ⇒ Refer to P33 

Install e-Parcel client software VCN-CommCenter 8.0  
and register ID Sharing. 

(*Register ID Sharing is available to multiple client PC.) 
 

Next, prepare in the ID Sharing Client PC. 

When VCN-AX 5.0 preparations completed, for new users, install the client software 

VCN-CommCenter 8.0 and operate to “Register ID Sharing”. Or, for the existing users of 

VCN-CommCenter 8.0, just operate to “Register ID Sharing” on the VCN-CommCenter GUI. 

 

In addition, in the VCN-CommCenter 8.0 ID Sharing Client PC, the operation “Register ID 

Sharing” is NOT required installing the e-Parcel client digital certificate of Sharing ID. 
 

*The “Register ID Sharing” on VCN-CommCenter 8.0 is available to multiple client PC. 
*You can set up both Private ID and Sharing ID to one VCN-CommCenter GUI, and then run the 

application both in Private Mode and in ID Sharing Mode. 
Private ID: Normal e-Parcel ID set up to VCN-CommCenter 8.0 

*One ID is available to one PC only as usual. (in Private Mode) 
Sharing ID: e-Parcel ID set up to VCN-AX 5.0 which is shared with VCN-CommCenter 8.0 

*Register ID Sharing is available to multiple client PC. (in ID Sharing Mode) 

 

At the beginning, to start ID Sharing function, please take the following advance preparations. 
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１. Preparations for e-Parcel VCN-AX 5.0 

【ID Sharing Host PC】 

First, let’s begin to prepare in the VCN- AX 5.0 ID Sharing Host PC. 

Import the e-Parcel client digital certificate of a sharing e-Parcel ID in OS, install the client software 

VCN-AX5.0 and auto setup. 

(*ID Sharing Host is available to one PC only.) 

 

For use in the “ID Sharing” function, after the application is installed, configure the 

automation functions (HotFolder, Receive Automation) for the same preparations in the VCN- 

AX 5.0 ID Sharing Host PC as usual. When VCN-CommCenter 8.0 preparations completed at 

the later operation (Register ID Sharing), the “ID Sharing” function will get started to work. 
*You may need the additional configurations such as remote access to VCN-AX 5.0 and connections 

through Windows Firewall to allow. 

 

 

 

 

Caution: If you sign in Windows with a user account without administrative 
privilege, administrative privilege is required. Therefore, prepare the 
following in advance depending on OS. 

[For Windows Vista or later]  

Prepare an administrator account name (administrator ID) and password.  

[For Windows 2000, XP, 2003]  

Log on Windows with either an administrator account or a user account with 
administrative privilege in advance. 

 

 

 

 

 

 

 

１ 
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1-1. Install VCN-AX 5.0 

When an e-Parcel ID for the “ID Sharing” is ready, visit the software download site bellow and 

operate from STEP 1 to STEP 6 described in the webpages to download and install both the 

e-Parcel client digital certificate and the client software e-Parcel VCN-AX 5.0 in the same way as 

usual. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

 

URL of e-Parcel software download site 
First, sign in Windows with a user account which runs the e-Parcel client software. 

 

１．Launch the browser application (using Microsoft Edge in this manual). Visit the URL below. 
* To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access 

Windows 10 or later "Start" menu > M > Microsoft Edge. 
 

 

URL of the “e-Parcel software download site”： https://www.e-parcel.ne.jp/ 

 

 

 

２．See the site appeared and then click the “Download & Install Software” menu on the site. 

 

 

３．Read the brief explanation about installation on the webpage, and then click the “Download 

e-Parcel Software” button (in blue) on the bottom of the current webpage. 
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Procedures to install digital certificate and software 
Take the instructions described in the STEP 1～6 webpages to download and install both your 

e-Parcel client digital certificate and the e-Parcel client software. 

 

 

The instructions on the “e-Parcel software download site” 

[STEP 1] 

Type an e-Parcel ID for the “ID Sharing” and the default password notified (or your own 

password), and then “Login” to the site. 

 

 

[STEP 2] 

Select one of the e-Parcel VCN-AX 5.0 which conforms to Windows operating system type 

(either 64bit or 32bit) of your computer. And then, click the “Next” button. 

 

 

[STEP 3] 

Check security of the current website which you visit, and then click the “Next” button. 

 

 

[STEP 4] 

To download a client digital certificate, leave the default choice of “For new users”, click the 

“Download” button, and then select "Open" the Certificate Import Wizard. 
 
To install (import) a client digital certificate in OS using the Certificate Import Wizard, follow the 

instructions described in the STEP 4 webpage. 
*Attention： On the way within Certificate Import Wizard, when password is required, be sure 

that you must click in the box “Make this key as exportable. ....” to set checked. (validated: on) 
When the Certificate Import Wizard is finished, click the “Next” button on the bottom of the 

STEP 4 webpage. 

 

 

[STEP 5] 

To verify connection to the URL of "The e-Parcel Secure Enterprise - Web Browser", follow the 

instructions described in the STEP 5 webpage. You may also change password as needed.  

Return to the instructions in the STEP 5 webpage, and then click the “Next” button.  
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[STEP 6] 

To download the e-Parcel client software, click the “Download” button to "Save" the e-Parcel 

VCN-AX 5.0 executable file in your computer. 

 

In Windows, the executable file is often saved automatically to This PC > “Downloads” folder 

with the default setting. 

(Or in the download notification bar of the browser window, select "Save as") 

[Executable file] 

Download location (Default): C:¥Users¥(Windows user account name)¥Downloads 

File name: [For 64bit: SetupVcnAx_5.0.xxxx_x64.exe] or [For 32bit: SetupVcnAx_5.0.xxxx.exe] 
*If you have changed Download Location in the browser settings “Downloads”, it might be 

saved to another location where you specified. 
 

To install the e-Parcel client software and auto setup, open the executable file to launch. Follow 

the instructions described in the STEP 6 webpage. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
*For the existing users of the “ID Sharing” function, after updating the client software in a computer, 

please be aware that you must modify the registry values to allow remote access again. 
Refer to P20 1-2. Allow remote access from Client PC to VCN-AX 5.0 
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How to open the VCN-AX 5.0 Management Console 
When the installation and auto-setup are completed, the Windows “Service” for the e-Parcel 

VCN-AX 5.0 gets started automatically. 

 

Open the “VCN-AX 5.0 Management Console” (browser-based). 
*Attention: It requires starting the “Service” to view the VCN-AX 5.0 Management Console. 
 

Double-click the  icon “e-Parcel VCN-AX 5.0” shown in the Windows taskbar notification area. Or, 

right-click the icon, then select “Open” from the menu. The “Management Console” new browser 

window will open. 

 

 

 

 

 
[How to make Windows show icon in the notification area on the taskbar] 
(By default, Windows does not show this icon on the taskbar: “Off”) 
[For Windows 10 or later] 
1. Right-click on the taskbar, then select “Taskbar settings” from menu.  

(Or, click Windows “Start” menu > Windows System > Control Panel > Appearance and 
Personalization > Taskbar and Navigation)  

2. On the Settings "Taskbar" window, under "Notifications Area", click “Select which icons appear 
on the taskbar".  

3. The icons list is displayed. Turn on the “VCN-AX Manager 5.0 [e-Parcel VCN-AX 5.0]” toggle to 
apply change to "On". 

*For more information, get help out of Windows. 
 
*If you exit the VCN-AX Manager by right-click the e-Parcel icon in the Windows taskbar notification area, 
or if you restart a computer with being disabled “AutoRun Manager” function, it does NOT start the 
VCN-AX Manager. Therefore, the e-Parcel icon won't appear in the Windows taskbar notification area. 
In this case, to start the VCN-AX Manager 5.0, click Windows “Start” menu > e-Parcel > “VCN-AX 
Manager 5.0”. 

OR 
 

Double-click the shortcut icon “VCN-AX 5.0” on the desktop. The “Management Console” new 

browser window will open. 

 

 

 

Way 1* 
Double-click taskbar 
notification area icon! 

Way 3 
Double-click 

shortcut icon on 
the desktop! 

Way 2* 
Right-click on the taskbar 

notification area icon! 
And select “Open” from 

the menus! 
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The Authorization “Credential” window 
On the VCN-AX 5.0 Management Console, select the menu “Authorization” > “Credential”. 

Confirm that the System Status shows "Online" normally. 

 

[VCN-AX 5.0 Management Console / Authorization > Credential] 

 

 

 

 

 

 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

 

Authorization 
> Credential 

[License information] 
Recipient Records / License Counts 

*Refer to P64 Address Book in CC8.0 & 
Recipient Records / License Count in AX5.0. 

The maximum number of recipient records 
must be limited to the license count as 
contracted with us. 

[System Status] 
Online: OK! 

*VCN-AX 5.0 succeeds in 
Internet access and login to the 

e-Parcel server to use the 
service normally. 

[Login Password Authentication] 
*Option function 
In the case of ①～③ below, it requires login password authentication 
when login to the e-Parcel server. Type password and then login. 

①If the server setting “Password Protect” function is enabled 
②On Configuration “System Config”, if the “Password Protect” function 

for Management console pages is enabled 
③In the case of above ①②, if you change password in the server 

setting 

Sharing ID 
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The “ID Sharing Client” window 
On VCN-AX 5.0 Management Console, select the menu “Authorization” > “ID Sharing Client”. 

After “Register ID Sharing” configured to VCN-CommCenter 8.0, the “ID Sharing Client” window 

will display list for information of the VCN-CommCenter 8.0 ID Sharing Client PC connected which 

are currently in use. (being Online). 

 

If VCN-CommCenter 8.0 in ID Sharing Mode is shut down (from the menu “File” > “Exit”), or if the 

“ID Sharing” function is disabled (P52) on VCN-CommCenter 8.0, the “ID Sharing Client” window 

won’t display information of the ID Sharing Client PC disconnected. 

 

[VCN-AX 5.0 Management Console / Authorization > ID Sharing Client] 

 
 

 

 

 

 

 

 

 

 

 

 

 

ID Sharing Client 

[ID Sharing Client] 
Information of 

VCN-CommCenter 8.0 
ID Sharing Client PC 
connected currently 

・Connected date & time 
・Host Name 
・IP Address 

123.44.77.88 

123.44.99.11 

123.0.0.1 

TEST-PC-1 

EP-TEST-64 
PC-EP-ABC-123 
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The Configuration “System Config” window 
When the installation and auto-setup are completed, on the VCN-AX 5.0 Management Console, 

select the menus “Configuration” > “System Config”, “User Config”, “HotFolder” and 

“Automation”. Configure the Automation functions (HotFolder, Receive Automation) to work as 

necessary. 

 

More details of the Configuration and the Automation functions (HotFolder, Receive Automation) in 

VCN-AX 5.0 can be found in the online manual listed in the site below.  
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

[VCN-AX 5.0 Management Console / Configuration > System Config (by default)] 

 

Configuration 
> System Config 

During “ID Sharing” 
VCN-AX 5.0 Host 
[System Config] 

(by default) 
Enable Resend: Yes 

Resend Period: 2 weeks 
Polling Interval: 5 minutes 

↓ 
These values are applied to 

“Option Config” 
in VCN-CommCenter 8.0 Clients 
*Refer: P59 CC8.0 “Option Config” 

For use of the Automation functions 
[HotFolder・Receive Automation] 

(by default) 
HotFolder Location 

C:¥e-Parcel¥HotFolders 
 

Automation Location 
C:¥e-Parcel¥Automations 

↓ 
Create HotFolders and Automation 

folders in the above locations. 
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Attention Users of VCN-AX 5.0 
When you configure the Automation functions (HotFolder, Receive Automation) including HotFolder 

and Automation Location of System Config, carefully read the description below if you specify the 

shared folders in network computer as HotFolder Location and/or as Automation Location. 

 

Attention: 
The “Service” for e-Parcel VCN-AX 5.0 often runs 

under the default setting of “Local System account” in Windows. 
Therefore, if you specify the shared folders in network PC 
as HotFolder Location, as Receive Automation Location or 

as destination folders for executing your external applications, 
the Automation functions might be dysfunctional  

due to the unauthorized logon account. 
Only domain user account or local user account of network PC 

 may usually be authorized to access the specified folders. 
 

The service for e-Parcel VCN-AX 5.0 must run under the appropriate Windows logon 

account which is authorized to access the specified folders. To change the account which 

the service can log on as, read the brief explanation for using the Windows interface of “Services” 

snap-in accordingly as follows. 

*For more information, get help out of Microsoft Windows. 
 
１．Click the Windows “Start” menu > Windows Administrative Tools > “Services”. 

[For Windows 8 or earlier] Click the Windows “Start” menu > Control Panel > System and Security 
(Performance and Maintenance) > Administrative Tools, and then double-click the “Services” shortcut 
to open. 

 

２．In the details pane of “Services”, right-click “e-Parcel VCN-AX 5.0”, select “Properties” to view its 
description, and then click the “Log On” tab. 

 
３．To specify the user account which the service can log on as, click “This account”, type or click 

Browse to specify an appropriate user account. Type the password for the user account in both 
“Password” and “Confirm password”, and then click “Apply”. To take effect, click “Restart the 
service” for e-Parcel VCN-AX 5.0. 

 

At last, when you change the user account which the service can log on as, please be 

sure that the Windows logon account must be authorized to “Modify” the 
specified folders as listed below. 
・HotFolder Location (Default: C:¥e-Parcel¥HotFolders)¥[your HotFolder(s)] 

・Automation Location (Default: C:¥e-Parcel¥Automations)¥[your Automation folder(s)] 

・Destination Folder for installation (Default: C:¥Program Files¥e-Parcel） 

・Database Location /Data Storage Path (Default: C:¥e-Parcel) 
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1-2. Allow remote access from Client PC to VCN-AX 5.0 

 

For use in the “ID Sharing” function, it requires configuring to allow remote access from 

VCN-CommCenter 8.0 ID Sharing Client PC to VCN-AX 5.0 ID Sharing Host PC. Remote access to 

VCN-AX 5.0 is often disabled with the default setting. 

(Default: allow only local access [localhost]) 

 

When remote access to VCN-AX 5.0 is allowed, you may also need to configure Windows Firewall to 
allow connections through TCP/9940 port, or to change port number. 
(Default: TCP/9940 port for VCN-AX 5.0 Interface） 

 

To change the setting for remote access to VCN-AX 5.0, take the procedures below. 

 

 

【How to allow remote access to VCN-AX 5.0】 
 

１．Stop the service for e-Parcel VCN-AX 5.0 using the Windows interface. 
*[For Windows 10 or later] Click the Windows “Start” menu > Windows Administrative Tools > 

Services. In the details pane of “Services”, select “e-Parcel VCN-AX 5.0”, and then click “Stop the 
service”. 

*[For Windows 8 or earlier] Click the Windows “Start” menu > Control Panel > System and Security 
> Administrative Tools > Services. In the details pane of “Services”, select “e-Parcel VCN-AX 5.0”, 
and then click “Stop the service”. 

 
*Attention: Please be aware that you must stop the service for e-Parcel VCN-AX 5.0 in advance 

to take effect appropriately before the setting is changed. 

 
 

 
*In addition, the operational procedures 1 and 2 are in no particular order. 

 

 

[Stop the service] 
Click! 

[Status] 
e-Parcel VCN-AX 5.0 

Running 
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２．To exit the VCN-AX Manager 5.0, right-click the  notification area icon “e-Parcel VCN-AX 5.0” 

on the Windows taskbar. Select the “Exit” from the pop-up menu appeared. 

 
*Attention: Please be aware that you must exit the VCN-AX Manager 5.0 in advance to take 

effect appropriately before the setting is changed. 

 

 

 

 

 

 
*Note: [For users of Windows] 
[How to make Windows show icon in the notification area on the taskbar] 
(By default, Windows does not show this icon on the taskbar: “Off”) 

1. Right-click on the taskbar, then select “Taskbar settings” from menu.  
(Or, click Windows “Start” menu > Windows System > Control Panel > Appearance and 
Personalization > Taskbar and Navigation)  

2. On the Settings "Taskbar" window, under "Notifications Area", click “Select which icons appear 
on the taskbar".  

3. The icons list is displayed. Turn on the “VCN-AX 5.0” toggle to apply change to "On". 
*For more information, get help out of Windows. 

 
*If you exit the VCN-AX Manager by right-click the e-Parcel icon in the Windows taskbar notification area, 

or if you restart a computer with being disabled “AutoRun Manager” function, it does NOT start the 
VCN-AX Manager. Therefore, the e-Parcel icon won't be shown in the Windows taskbar notification 
area.  

 

 

 

 

 

 

 

Right-click the notification 
area icon on the taskbar! 

Select “Exit”! 
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３．Launch the Windows interface of “Registry Editor”. 
*[For Windows 10 or later] Click the Windows “Start” menu > Windows Administrative Tools > 

Registry Editor 
*[For Windows 8 or earlier] Click the Windows “Start” menu > click in the “Search programs and files 

(Run)” box > Type “regedit.exe”, and then press “Enter” key. > Registry Editor 
 

*If the “User Account Control (UAC)” dialog appears, select the “Yes” button to allow. Or, in the case 
of sign in Windows with a standard account without administrative privilege, administrator ID 
(account name) and password are required to input. 
 

the “Registry Editor” dialog opens. 
*Attention: Please be aware that you must carefully make changes in the “Registry Editor” 
dialog. Because it is possible that a mistake in the registry value was the cause of the trouble 
such as the application may not run normally. 

 

Locate Computer¥KEY_LOCAL_MACHINE¥SOFTWARE¥e-Parcel¥VCN-AX 5.0 on the left pane. 

Registry Editor will list the values of VCN-AX 5.0 Key on the right pane. 

In the Name column, right-click [ListenHost], and then select “Modify” from the menu appeared. 

 
 

 

 

 

 

 

 

Name [ListienHost] 
Right-click! 

↓ 
Select “Modify”! 
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The “Edit String” dialog opens. 

To allow remote access to VCN-AX 5.0, click in the “Value data” box, type an IP Address of 

VCN-AX 5.0 ID Sharing Host PC, and then click OK button. 

 

【Value name: ListenHost】 

【Value data: *Type below.】 

・To allow only local access: (Default) 

localhost 

 

・To allow remote access to a particular IP Address: (Allow to one IP Address) 

An IP Address of VCN-AX 5.0 ID Sharing Host PC 

 

・To allow remote access to any of IP Address: (Allow to multiple IP Addresses) 

0.0.0.0 
*In the case that you wish to allow remote access to multiple IP addresses which are assigned to 

VCN-AX 5.0 ID Sharing Host PC, configure to allow remote access to any of IP Address as stated 
just above.  

 

 

 

 

 

 

 

 

 

 

 

 

 

[Value data] 
Type an IP Address of Host PC. 

(Allow remote access) 
↓ 

OK! 
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*When remote access to VCN-AX 5.0 is allowed, you may also need to configure Windows 
Firewall to allow connections through TCP/9940 port, or to change port number. 
 

【How to change port number】 

As the procedures described above, Registry Editor will list up the values of VCN-AX 5.0 Key on 

the right pane. In the Name column, right-click [ListenPort], and then select “Modify” from the 

menu appeared. The “Edit DWORD (32-bit) Value” dialog opens. 

In the “Base”, click “Decimal” to change the display. 

Click in the “Value data” box, type a port number of VCN-AX 5.0 ID Sharing Host PC, and then 

click OK button. 

 

【Value name: ListenPort】 

【Value data: 9940[Decimal]】(Default: TCP/9940 port) 

TCP port number for VCN-AX 5.0 Interface 

 

 

 

 

 

 

 

 

 

Caution: At the same time that you uninstall (delete) e-Parcel VCN-AX 5.0 

from a computer, the following registry key of VCN-AX 5.0 will be deleted. 

(Computer¥KEY_LOCAL_MACHINE¥SOFTWARE¥e-Parcel¥VCN-AX 5.0) 

Therefore, after updating the client software in a computer, please be aware 

that you must modify the registry values to allow remote access again. 

 

 

[Value data] 
Type a port number 

[Decimal]. 
↓ 

OK! 
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４．To launch the VCN-AX Manager 5.0, click the Windows “Start” menu. 

[For Windows 10 or later] Click the Windows “Start” menu > e-Parcel > VCN-AX Manager 5.0 
[For Windows 8 or earlier] Click the Windows “Start” menu > All programs > e-Parcel > VCN-AX 
5.0 > VCN-AX Manager 5.0 

 

[For Windows 10 or later] 

 

 

 

 

 

 

 
*In addition, the operational procedures 4 and 5 are in no particular order. 

 

 

 

 

 

E > e-Parcel > 
VCN-AX Manager 5.0 

Click 
Windows Start! 
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５．Start the service for e-Parcel VCN-AX 5.0 using the Windows interface. 
*[For Windows 10 or later] Click the Windows “Start” menu > Windows Administrative Tools > 

Services. In the details pane of “Services”, select “e-Parcel VCN-AX 5.0”, and then click “Start the 
service”. 

*[For Windows 8 or earlier] Click the Windows “Start” menu > Control Panel > System and Security 
> Administrative Tools > Services. In the details pane of “Services”, select “e-Parcel VCN-AX 5.0”, 
and then click “Start the service”. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

[Start the service] 
Click! 

[Status] 
e-Parcel VCN-AX 5.0 

Stopped 
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６．At the end, to verify that the changes of the registry values have been reflected correctly, open 

the VCN-AX 5.0 Management Console. 

 

【To verify in the VCN-AX 5.0 ID Sharing Host PC】 

Double-click the  icon “e-Parcel VCN-AX 5.0” shown in the Windows taskbar notification area. Or, 

Double-click the shortcut icon “VCN-AX 5.0” on the desktop. 
*Refer to P15 How to open the VCN-AX 5.0 Management Console 

 

 

OR 
 

【To verify in the VCN-AX 5.0 ID Sharing Host PC or in other PC】 

Launch the browser, click in the URL address bar, type as below [After the change: New URL] of 

the VCN-AX 5.0 Management Console, and then press “Enter” key to browse. 

 

[Before the change: URL (Default)] http://localhost:9940/ 

 

 

 

 

[After the change: New URL] http:// The specified IP Address (or host name):9940/ 

*When the registry value of port number has been changed, type a new port number in URL. 

For example: URL：http://123.45.67.89:9940/ 

 

 

Double-click taskbar 
notification area icon! 

(Shown in color: Online) 



e-Parcel ID Sharing function Operation Guide EN                                             EP-PM-MN-0381 

Copyright© e-Parcel Corporation All rights reserved. 28 

 

1-3. Change settings for Windows Defender Firewall 

 

For use in the “ID Sharing” function, it requires to allow the application to communicate through 

Windows Firewall. 

(Default: Disallow VCN-AX 5.0 through Windows Firewall) 

 
To change the setting to allow VCN-AX 5.0 to communicate through Windows Defender Firewall, 
take the procedures below. 

 

 

【How to allow VCN-AX 5.0 through Windows Firewall】 
*For more information, get help out of Microsoft Windows. 

 

１．View the Control Panel by category. In System and Security, you can configure to “Allow an app 

through Windows Firewall”. 
*[For Windows 10 or later] Click the Windows “Start” menu > Windows System > Control Panel > 

System and Security > Windows Defender Firewall, and then click “Allow an app through Windows 
Firewall”. 

*[For Windows 8 or earlier] Click the Windows “Start” menu > Control Panel > System and Security 
> Windows Firewall, and then click “Allow an app through Windows Firewall”. 

 

 

 

 

 

 

 

 

 

Click! 
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２．The “Allowed apps (Programs)” dialog opens. 

Click the “Change settings” button. (*Administrative privilege required) 
*If the “User Account Control (UAC)” dialog appears, select the “Yes” button to allow. Or, in the case 

of sign in Windows with a standard account without administrative privilege, administrator ID 
(account name) and password are required to input. 

 

 
 

 

 

Click the “Allow another app” button enabled (in color). 

 

 

Change settings 
*Administrative privilege required 

Allow another app… 
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３．The “Add an app (Program)” dialog opens. Click the “Browse” button to find one. 

 

 

 

 

On the “Browse” dialog, specify a program file stored in the following installation directory of 

e-Parcel VCN-AX 5.0, and then click the “Open” button. 

[Destination Folder for installation (Default): C:¥Program Files¥e-Parcel¥VCN-AX 5.0¥vcnax.exe] 

 

 

Browse… 

Open! 

specify 
vcnax.exe! 
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４．On the “Add an app (Program)” dialog, in the “Apps (Programs):” box, select “VCN-AX” which 

you previously specified a program file, and then click the “Add” button. 

 

 

 

 

 

 

 

 

 

Add! 

VCN-AX 
selected!

! 
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５．On the “Allowed apps (Programs)” dialog, in the “Allowed apps and features:” box, confirm that 

“VCN-AX” is added in the Name column. When you are finished, click the “OK” button to exit. 

 

 
 

 

 

 

 

 

 

 

 

When the preparations in the e-Parcel VCN-AX 5.0 ID Sharing Host PC have been completed, you 

can start the Preparations for the e-Parcel VCN-CommCenter 8.0 ID Sharing Client PC. 

 

OK！ 

VCN-AX 
Added! 
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２．Preparations for e-Parcel VCN-CommCenter 8.0 

【ID Sharing Client PC】 

Next, let’s begin to prepare in the VCN- CommCenter 8.0 ID Sharing Client PC. 

When VCN-AX 5.0 preparations completed, for new users, install the client software 

VCN-CommCenter 8.0 and operate to “Register ID Sharing”. Or, for the existing users of 

VCN-CommCenter 8.0, just operate to “Register ID Sharing” on the VCN-CommCenter GUI. 

(*Register ID Sharing is available to multiple client PC.) 

 

In addition, in the VCN-CommCenter 8.0 ID Sharing Client PC, the operation “Register ID Sharing” 

is not required installing the e-Parcel client digital certificate of Sharing ID. 
 
*The “Register ID Sharing” on VCN-CommCenter 8.0 is available to multiple client PC. 
*You can set up both Private ID and Sharing ID to one VCN-CommCenter GUI, and then run the 

application both in Private Mode and in ID Sharing Mode. 
Private ID: Normal e-Parcel ID set up to VCN-CommCenter 8.0 

*One ID is available to one PC only as usual. (in Private Mode) 
Sharing ID: e-Parcel ID set up to VCN-AX 5.0 which is shared with VCN-CommCenter 8.0 

*Register ID Sharing is available to multiple client PC. (in ID Sharing Mode) 

 

 

Caution: In advance, confirm that an e-Parcel ID for the “ID Sharing” 

has been set up completely to the VCN-AX5.0 ID Sharing Host PC 

before you begin to prepare in the VCN- CommCenter 8.0 ID Sharing Client PC. 

If not yet in the VCN-AX 5.0 ID Sharing Host PC, you would fail in the operation 

“Register ID Sharing” on VCN-CommCenter 8.0. 

 

 

Caution: If you sign in Windows with a user account without administrative 
privilege, the software installation requires administrative privilege at 
later step. Therefore, prepare the following in advance depending on OS. 

[For Windows Vista or later] 

Prepare an administrator account name (administrator ID) and password. 

[For Windows 2000, XP, 2003] 

Log on Windows with either an administrator account or a user account with 
administrative privilege in advance. 

 

 

 

２ 
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*Note that you must obtain information [Host name or IP Address] and [Port number (Default: 

9940)] of the VCN-AX 5.0 ID Sharing Host PC in advance. When you are ready, begin the 

operational procedures below. 

 

 

 

 

 

 

 

To operate “Register ID Sharing”, take either one procedure 2-1. or 2-2. depending on your 

situation. 

 

 

【For new users who have not installed VCN-CommCenter 8.0 yet】 

2-1. To install VCN-CommCenter 8.0 and operate to “Register ID Sharing” 

→ Proceed to P35 2-1. Install VCN-CommCenter 8.0 & Register ID Sharing 

 

 

 

OR 
 

 

 

【For the existing users who have already installed VCN-CommCenter 8.0】 

2-2. To operate to “Register ID Sharing” on the existing VCN-CommCenter 8.0 

→ Proceed to P41 2-2. Launch VCN-CommCenter 8.0 & Register ID Sharing 
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2-1. Install VCN-CommCenter 8.0 & Register ID Sharing 

After you confirmed that the preparations in the e-Parcel VCN-AX 5.0 ID Sharing Host PC have been 

completed, visit the software download site bellow, and then operate from STEP 1～3 and STEP 6 

described in the webpages to download and install the client software e-Parcel VCN-CommCenter 

8.0. (without requiring STEP 4～5 operations for certificate installation when “Register ID Sharing”) 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

In addition, in the VCN-CommCenter 8.0 ID Sharing Client PC, the operation “Register ID Sharing” 

is NOT required installing the e-Parcel client digital certificate of Sharing ID. 

 

 

URL of e-Parcel software download site 
First, sign in Windows with a user account which runs the e-Parcel client software. 

 

１．Launch the browser application (using Microsoft Edge in this manual). Visit the URL below. 
* To launch Edge, click icon on the taskbar, double-click the desktop shortcut icon, or access 

Windows 10 or later "Start" menu > M > Microsoft Edge. 
 
 

URL of the “e-Parcel software download site”： https://www.e-parcel.ne.jp/ 

 

 

 

２．See the site appeared and then click the “Download & Install Software” menu on the site. 

 

 

３．Read the brief explanation about installation on the webpage, and then click the “Download 

e-Parcel Software” button (in blue) on the bottom of the current webpage. 
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Procedures to install software 
Take the instructions described in the STEP 1～3 and STEP 6 webpages to download and install the 

e-Parcel client software. (without requiring STEP 4～5 operations) 

 

 

The instructions on the “e-Parcel software download site” 

[STEP 1] 

Type an e-Parcel ID and password, and then “Login” to the site. 

 

 

[STEP 2] 

Select one of the e-Parcel VCN-CommCenter 8.0 which conforms to Windows operating system 

type (either 64bit or 32bit) of your computer. And then, click the “Next” button. 

 

 

[STEP 3] 

Check security of the current website which you visit, and then click the “Next” button. 
*Click the “Next” button to proceed to [STEP 6]. 

 

 

[STEP 4] 

Skip this step. Installation of a client digital certificate is Not required. 

Click the “Next” button on the bottom of webpage. 

 

 

[STEP 5] 

Skip this step. Operation on "The e-Parcel Secure Enterprise - Web Browser" is Not required. 

Click the “Next” button on the bottom of webpage. 
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[STEP 6] 

To download the e-Parcel client software, click the “Download” button to "Save" the e-Parcel 

VCN-CommCenter 8.0 executable file in your computer. 

 

In Windows, the executable file is often saved automatically to This PC > “Downloads” folder 

with the default setting. 

(Or in the download notification bar of the browser window, select "Save as") 

[Executable file] 

Download location (Default): C:¥Users¥(Windows user account name)¥Downloads 

File name: [For 64bit: SetupVcnCC_8.0.xxxx_x64.exe] or [For 32bit: SetupVcnCC_8.0.xxxx.exe] 
*If you have changed Download Location in the browser settings “Downloads”, it might be 

saved to another location where you specified. 
 

 

 

 

 

 

To install the e-Parcel client software, proceed to either one procedure A or B depending on 

condition in your computer. 

 

 

A. When you have NOT installed any e-Parcel client digital certificate in your computer, 

→ Proceed to P38 Procedure A. 

 

 

 

B. Once you have installed e-Parcel client digital certificates in your computer, 
*If you are not sure whether certificate installations exist, choose this procedure B. 

→ Proceed to P39 Procedure B. 
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A. When you have NOT installed any e-Parcel client digital certificate in a computer 

 
To install the e-Parcel client software, open the executable file to launch. Follow the instructions 
described in the STEP 6 webpage. 

 

At the end, the e-Parcel VCN-CommCenter 8.0 – InstallShield Wizard will show the message 

“InstallShield Wizard Completed”. (See figure below) 

☑ “Launch the program” (enabled) 

(Default: set checked) 

Leave the default setting to be checked. Just click the “Finish” button to exit. 

 

 

 
*Attention: From this operational procedure, carefully read the instructions below in this manual 

which show you the different procedures from the STEP 6 webpage. You don’t need to auto 
setup the e-Parcel client digital certificate in this time. 

 

The “Register ID Sharing” dialog will open automatically when the client software e-Parcel 

VCN-CommCenter 8.0 installation completed. 

→ Proceed to P43 2-3. “Register ID Sharing” on VCN-CommCenter 8.0 
*If the “Select a Certificate” appears automatically instead of the “Register ID Sharing” dialog, click 

“Cancel”. Then, open the “Register ID Sharing” dialog from Windows “Start” menu. (Refer to P40) 
*If auto setup has been done automatically without the “Register ID Sharing” dialog opened, the 

VCN-CommCenter GUI might open. Under this situation, try from the “Tool” menu on GUI to open 
the “Register ID Sharing” dialog. (Refer to P42) In addition, if another unnecessary e-Parcel ID 
(Private ID) has been set up, disable this ID. (Refer to P52) 

 

Finish! 
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B. Once you have installed e-Parcel client digital certificates in a computer 

*If you are not sure whether certificate installations exist in a computer, choose this procedure B. 

 

To install the e-Parcel client software, open the executable file to launch. Follow the instructions 
described in the STEP 6 webpage until the following figure is shown. 

 
*Attention: From this operational procedure, carefully read the instructions below in this manual 

which show you the different procedures from the STEP 6 webpage. You don’t need to auto 
setup the e-Parcel client digital certificate in this time. 

At the end, the e-Parcel VCN-CommCenter 8.0 – InstallShield Wizard will show the message 

“InstallShield Wizard Completed”. (See figure below) 

Click in the check box ☐ “Launch the program” to be unchecked. (disabled) 

(Default: set checked) 

 

Make sure to remove a check from the box, and then click the “Finish” button to exit. 

When the e-Parcel VCN-CommCenter 8.0 installation completed, the application will shut down. 

 

 

 

 

 

 

 

Uncheck 
in this box! 

Finish! 
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Open “Register ID Sharing” dialog from Windows Start menu 
Click the Windows “Start” menu. 

[For Windows 10 or later] Click the Windows “Start” menu > e-Parcel > Register ID Sharing 
[For Windows 8 or earlier] Click the Windows “Start” menu > All programs > e-Parcel > 
VCN-CommCenter 8.0 > Register ID Sharing 

 

[For Windows 10 or later] 

 
 

 

 

 

 

 

 

The “Register ID Sharing” dialog will open. 

→ Proceed to P43 2-3. “Register ID Sharing” on VCN-CommCenter 8.0 
*If the VCN-CommCenter GUI just opens without the “Register ID Sharing” dialog opened, try from 

the “Tool” menu in GUI to open the “Register ID Sharing” dialog. (Refer to P42) 

 

 

E > e-Parcel > 
Register ID Sharing 

Click 
Windows Start! 
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2-2. Launch VCN-CommCenter 8.0 & Register ID Sharing 

For the existing users of VCN-CommCenter 8.0, just operate to “Register ID Sharing” on the 

VCN-CommCenter 8.0 in which other e-Parcel ID (Private ID) have been set up as usual. In this 

case, you can use both Private ID and Sharing ID on one VCN-CommCenter GUI.  

 

In addition, in the VCN-CommCenter 8.0 ID Sharing Client PC, the operation “Register ID Sharing” 

is NOT required installing the e-Parcel client digital certificate of Sharing ID. 

 

*The “Register ID Sharing” on VCN-CommCenter 8.0 is available to multiple client PC. 
*You can set up both Private ID and Sharing ID to one VCN-CommCenter GUI, and then run the 

application both in Private Mode and in ID Sharing Mode. 
Private ID: Normal e-Parcel ID set up to VCN-CommCenter 8.0 

*One ID is available to one PC only as usual. (in Private Mode) 
Sharing ID: e-Parcel ID set up to VCN-AX 5.0 which is shared with VCN-CommCenter 8.0 

*Register ID Sharing is available to multiple client PC. (in ID Sharing Mode) 

 

 

After you confirmed that the preparations in the e-Parcel VCN-AX 5.0 ID Sharing Host PC have been 

completed, take the following procedures. 
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Open “Register ID Sharing” dialog from VCN-CommCenter GUI 
To launch the existing client software VCN-CommCenter 8.0 and open GUI in your computer, 

double-click the “e-Parcel 8.0” shortcut icon on the desktop. 

 

On VCN-CommCenter GUI, select Tool > Register ID Sharing from the menu bar. 

 

 

 

 

 

 

 

 

 

The “Register ID Sharing” dialog will open. 

→ Proceed to P43 2-3. “Register ID Sharing” on VCN-CommCenter 8.0 

 

 

Tool > 
Register ID Sharing 

Existing 
Private ID 
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2-3. “Register ID Sharing” on VCN-CommCenter 8.0 
*Note that you must obtain information [Host name or IP Address] and [Port number (Default: 

9940)] of the VCN-AX 5.0 ID Sharing Host PC in advance. 
 

 

Caution: In advance, confirm that an e-Parcel ID for the “ID Sharing” 

has been set up completely to the VCN-AX5.0 ID Sharing Host PC 

before you begin to prepare in the VCN- CommCenter 8.0 ID Sharing Client PC. 

If not yet in the VCN-AX 5.0 ID Sharing Host PC, you would fail in the operation 

“Register ID Sharing” on VCN-CommCenter 8.0. 

 

As mentioned in the previous sections, to open the “Register ID Sharing” dialog, take the either 

operation below. 

・P40 Open “Register ID Sharing” dialog from Windows “Start” menu (For new users) 

・P42 Open “Register ID Sharing” dialog from menu on VCN-CommCenter GUI (For existing users) 

 

The “Register ID Sharing” dialog 
To share the e-Parcel ID set up to VCN-AX 5.0 with VCN-CommCenter 8.0, configure 

using the “Register ID Sharing” dialog. (*available to multiple client PC) 

The details of settings in the “Register ID Sharing” dialog can be found in the following pages of 

this manual. Carefully read, and then configure. 

[Register ID Sharing] dialog 

 

[Register New] 
VCN-AX 5.0 ID Sharing Host PC 

IP Address or Host name 
Port number: 9940 (default) 

Type! 
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Display Name 
(Default: Register New) 

When you register new ID sharing, leave the default value of “Register New”. 
*If you have already registered to share other ID, the Sharing ID might be listed in the pull-down menu. 

 

When “Register ID Sharing” configured, the e-Parcel ID shared with VCN-AX 5.0 will be set as initial 

value for the “Display Name”. It is usually displayed on the tree view of the VCN-CommCenter GUI. 
*If you wish to change the value of “Display Name”, refer to the page below of this manual to configure. 

Refer to P50 One-point Advice for VCN-CommCenter GUI 

 

 

 

Host Name 
IP Address or Host Name of VCN-AX 5.0 ID Sharing Host PC 
If you are not sure of it, obtain the correct information to ask user who runs the VCN-AX 5.0 ID 
Sharing Host PC. 
*For use in the “ID Sharing” function, it requires configuring Host PC to allow remote access from 

VCN-CommCenter 8.0 ID Sharing Client PC to VCN-AX 5.0 ID Sharing Host PC in advance. 
(Default: Allow only local access [localhost]) 
Refer to P20 1-2. Allow remote access from Client PC to VCN-AX 5.0 

 

 

 

Port Number 
(Default: 9940) 

TCP port number for VCN-AX 5.0 Interface 
If you are not sure of it, obtain the correct information to ask user who runs the VCN-AX 5.0 ID 
Sharing Host PC. 
*When remote access to VCN-AX 5.0 is allowed, Host PC may also need to configure Windows Firewall 

to allow connections through TCP/9940 port, or to change port number. 
(Default: TCP/9940 port for VCN-AX 5.0 Interface） 
Refer to P20 1-2. Allow remote access from Client PC to VCN-AX 5.0 
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Proxy Settings 
(Default: Automatic) 

For use in the “ID Sharing” function, when the firewall relays remote access from 

VCN-CommCenter 8.0 ID Sharing Client PC to VCN-AX 5.0 ID Sharing Host PC, the proxy settings 

are required to allow connections through the firewall. 

 

More details of the proxy settings in VCN-CommCenter 8.0 can be found in the section User 

Configuration > Proxy Settings of the online manual listed in the site below.  
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

 

Caution: To successfully connect through the firewall when remote access 
from VCN-CommCenter 8.0 ID Sharing Client PC to VCN-AX 5.0 ID Sharing Host 
PC, the correct proxy settings must be supplied. If you are not sure of the proxy 
settings, it is strongly recommended that you contact your company's network 
administrator or service provider to obtain the correct network information. 

 

Automatic 

“Automatic” proxy setting by default 

In the case of “Not using Proxy” or “Automatic Proxy Detection”, leave the initial choice “Automatic”.  

The VCN-CommCenter 8.0 attempts to automatically detect your computer’s proxy settings 

(Windows) while configuring “Register ID Sharing”. 
*For your reference: [How to confirm your computer’s proxy settings (Windows)] 
Access Windows “Start” menu > Windows System > Control Panel > Network and Internet > 
Internet Options. In the “Internet Properties” dialog, on the “Connections” tab, under the “Local 
Area Network (LAN) Settings”, click “LAN settings” button. Confirm the “Proxy server” settings. 
 
[How to open your computer’s proxy settings using Microsoft Edge] 
Launch Microsoft Edge. On toolbar at the upper-right, click […] (Settings and more) > Settings 
(gear icon) > System and performance > System > Open your computer’s proxy settings > the 
“Proxy” dialog. 

 

 

Manual 
To manually configure the proxy settings when configuring “Register ID Sharing”, choose the 

“Manual”. Type in Proxy Settings “Host Name”, “Port Number”, and then choose either one proxy 

type. As needed, click in the “Bypass proxy server…” box. 

 

 
*If the proxy server requires user authentication, while configuring “Register ID Sharing”, the “Proxy 

Authentication Required” dialog will appear. (P47) 
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In the “Register ID Sharing” dialog, when you are finished, click “OK” button to start configuring. 

 

 

 

 

 

 

 

 

 

 

In processing “Register ID Sharing”, it shows “Setup is Proceeding…”. Wait for a while. 

 

 

 

 

 

 

When finished, 
OK! 

[Proxy Settings] 
Automatic (by default): 

Software automatically detects 
your computer’s proxy settings! 

[Register New] 
VCN-AX 5.0 ID Sharing Host PC 

IP Address or Host name 
Port number: 9940 (default) 

Confirm! 
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Proxy Authentication 
If your proxy server requires user authentication, the “Proxy Authentication Required” dialog may 

appear while configuring “Register ID Sharing”. The “User Name” and “Password” are required to 

authenticate in the proxy server. Take either one below depending on the proxy authentication 

methods. 

 

[In the case of NTLM Authentication or Integrated Windows Authentication] 

Leave blank in the proxy credentials (User name, Password, Checkbox “Remember this…”). Then, 

click "OK" button.  
*Because when it is not given any proxy credentials, Windows Single Sign On function will work to 
automatically apply Windows user account name and password for proxy authentication.  

 

[In the cases of the other authentication methods than the above] 

Input the proxy credentials (User name, Password). 

Once you place a check in the checkbox “Remember this authentication info.”, the “Proxy 

Authentication Required” dialog no longer appear whenever login upon start software, auto-setup, 

import certificate or etc. Then, click “OK” button to authenticate.  

 
*If you are not sure of your computer’s proxy settings and the proxy credentials (user name and 
password), to obtain the correct information, please contact your system/firewall administrator or 
service provider. 

 

 

 

 

 

 

 

 

[Proxy Authentication Required] 
Type User Name and Password! 
Set checked in box to remember 

as needed. 
↓ 

OK! 

*If using the proxy 
server with NTLM or 
Integrated Windows 

Authentication,  
leave all fields blank. 

↓ 
OK! 
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When “Register ID Sharing” configured successfully, the tree view in the upper-left pane on the 

VCN-CommCenter GUI displays a folder tree (including Inbox and Outbox) for the Sharing ID 

which has been set up to VCN-AX 5.0. 

 

Also, during use of the “ID Sharing” function, the histories recorded in outbox and inbox 

can be shared with VCN-AX 5.0 and all of VCN-CommCenter 8.0 in ID Sharing Mode. 

 

 

[For new users who install VCN-CommCenter 8.0 and operate to “Register ID Sharing”] 

 
 

 

OR 
 

 

[For the existing users who additionally operate to “Register ID Sharing” on VCN-CommCenter 8.0] 
*You can run e-Parcel VCN-CommCenter 8.0 both in Private Mode and in ID Sharing Mode. 

Private ID: Normal e-Parcel ID set up to VCN-CommCenter 8.0 as usual (in Private Mode) 
Sharing ID: e-Parcel ID set up to VCN-AX 5.0 which is shared with VCN-CommCenter 8.0 (in ID Sharing Mode) 

 

 

 

 

 

Sharing ID 

Existing 
Private ID 

 

Sharing ID 
*Additionally, 

displayed. 
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At last, confirm the system status “Online” shown in the bottom-right on the VCN-CommCenter 

GUI. 

 

[VCN-CommCenter GUI] 

 

 

 

 

You have done the preparations for using the “ID Sharing” function in VCN-CommCenter 8.0.  

To send and receive data in ID Sharing Mode, you can operate in the same way as Private Mode. 
*The section below of this manual briefly explains how to send and receive data. 

Refer to P70 3. Using ID Sharing function – 3-4. How to use ID Sharing function 

 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

 

 

 

 

 

 

[System Status] 
Online: OK! 

*During “ID Sharing”, 
it succeeds in remote access to 

VCN-AX 5.0 Host PC. 
The e-Parcel service is 

available. 
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One-point Advice for VCN-CommCenter GUI 

For the existing users who additionally operate to “Register ID Sharing” on VCN-CommCenter 8.0, 

in the case of using multiple e-Parcel ID on one VCN-CommCenter GUI, you can 

customize display name and display order for multiple e-Parcel ID to make them easier to use 

on the VCN-CommCenter GUI. 

 

To change Display Name 
Usually, when e-parcel ID configured (Auto Setup, Import Certificate, Register ID Sharing) on 

VCN-CommCenter 8.0, the tree view in the upper-left pane on the VCN-CommCenter GUI displays 

a folder tree (including Inbox and Outbox) with the “Display Name” for which the e-Parcel ID has 

been set as initial value. To change the “Display Name”, take the following procedure. 

① On the upper-left pane of the VCN-CommCenter GUI, in the tree view, click the e-Parcel ID 

[Display Name] that you want to configure. 
 

② In the “User Configuration” pane, change in the “Display Name” to be easy to follow. 
 

③ To take effect, click “Save” button in the bottom-right of the “User Configuration” pane. 

 

[VCN-CommCenter 8.0 in ID Sharing Mode: “User Configuration” pane] 

 

 

 
 

 

 

[Display Name] 
①Click ID! 

②Change! 

③Save! 

After changed! 

123.44.55.66 (9940) 

123.44.55.66 (9940) 
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To change Display Order 
Usually, when multiple e-parcel ID configured (Auto Setup, Import Certificate, Register ID Sharing) 

on one VCN-CommCenter GUI, the tree view in the upper-left pane on the VCN-CommCenter GUI 

displays multiple folder trees (including Inbox and Outbox) in order configured. To change display 

order for multiple e-Parcel ID to make them easier to use on the VCN-CommCenter GUI, take the 

following procedure. 

① On the upper-left pane of the VCN-CommCenter GUI, in the tree view, to open the menu, 

right-click the e-Parcel ID [Display Name] that you want to configure. 
 

② Click “Move Up” or “Move down”. 

While processing, it shows “Setup is Proceeding…”. 

 

 

 

 

②Click 
Move Up! 

(or Move Down) 

[Display Name] 
①Right-click ID 
to open menu! 

After changed! 
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2-4. Disable ID Sharing on VCN-CommCenter 8.0 

To disable the “ID Sharing” function on e-Parcel VCN-CommCenter 8.0, take the following 

procedure in the same way as Private ID. 
*After “ID Sharing” disabled, if you wish to re-register “ID Sharing” for the same e-Parcel ID as before, 

the operation “Register ID Sharing” is required similarly as “Register New”. Please be aware that the 
previous information of “Register ID Sharing” could not be recovered. 

 

① On the upper-left pane of the VCN-CommCenter GUI, in the tree view, to open the menu, 

right-click the e-Parcel ID [Display Name] that you want to disable. 

② Click “Disable this ID”. 

While processing, it shows “Setup is Proceeding…”. 

 
 

 

 

 

 

 

[Display Name] 
①Right-click ID 
to open menu! 

②Click! 

After disabled! 



e-Parcel ID Sharing function Operation Guide EN                                             EP-PM-MN-0381 

Copyright© e-Parcel Corporation All rights reserved. 53 

３．Using ID Sharing function 

For use in the “ID Sharing” function, when the preparations both in the e-Parcel VCN-AX 5.0 Host 

PC and in the e-Parcel VCN-CommCenter 8.0 Client PC have been completed, to send and receive 

data in ID Sharing Mode, you can operate in the same way as Private Mode. 

 

*The “Register ID Sharing” on VCN-CommCenter 8.0 is available to multiple client PC. 
*You can set up both Private ID and Sharing ID to one VCN-CommCenter GUI, and then run the 

application both in Private Mode and in ID Sharing Mode. 
Private ID: Normal e-Parcel ID set up to VCN-CommCenter 8.0 

*One ID is available to one PC only as usual. (in Private Mode) 
Sharing ID: e-Parcel ID set up to VCN-AX 5.0 which is shared with VCN-CommCenter 8.0 

*Register ID Sharing is available to multiple client PC. (in ID Sharing Mode) 

 

 

However, on VCN-CommCenter 8.0, some settings and functions of User Configuration, 

Option Configuration and Address Book in ID Sharing Mode are different from Private 

Mode. The following descriptions in this section will introduce difference in the settings and 

functions which are interlocked with the configurations of VCN-AX 5.0. 

 

 

 

 

 

 

 

３ 



e-Parcel ID Sharing function Operation Guide EN                                             EP-PM-MN-0381 

Copyright© e-Parcel Corporation All rights reserved. 54 

 

3-1. User Configuration in VCN-CommCenter 8.0 

To view the “User Configuration” pane, on the upper-left pane of the VCN-CommCenter GUI, in 

the tree view, click the e-Parcel ID [Display Name] that you want to configure. In the case of using 

multiple e-Parcel ID on one VCN-CommCenter GUI, the changes in User Configuration affect the 

current e-Parcel ID that you select at this time. 

 

On VCN-CommCenter 8.0, some settings of User Configuration in ID Sharing Mode are 

functionally different from Private Mode. 

During use of the “ID Sharing” function, the details of difference in the settings “Information of 

Register ID Sharing”, “Login Password”, “Default Account” and “Data Storage Path” of User 

Configuration can be found from the next page of this manual. 

 

For your information, more details of User Configuration in VCN-CommCenter 8.0 can be found in 

the section “User Configuration” of the online manual listed in the site below. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

 

[VCN-CommCenter 8.0 in ID Sharing Mode: “User Configuration” pane] 

 

 

 

 

 

 

 

 

 

 

 

123.44.55.66 (9940) 

[Display Name] 
Click Sharing ID! 
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3-1-1. Information of “Register ID Sharing”  
【Display Name ・ e-Parcel ID ・ ID Sharing Host Name ・ Proxy Settings】 
Information of “Register ID Sharing” configured is displayed in the “User Configuration” 

pane on VCN-CommCenter 8.0 in ID Sharing Mode. 
*For mor details about the settings of “Display Name” ～ “Proxy Settings”, refer to the section below of 

this manual. 
Refer to P43 2-3. “Register ID Sharing” on VCN-CommCenter 8.0 

 

[VCN-CommCenter 8.0 in ID Sharing Mode: “User Configuration” pane] 

 

 

 

 

123.44.55.66 (9940) 
[Information of Register ID Sharing] 
・Display Name 
・Sharing e-Parcel ID 
・Host name (Port number) of  

VCN-AX 5.0 Host PC 

Proxy Settings 
*If remote access to VCN-AX 
5.0 Host PC requires through 
firewall, configure to allow. 

Sharing ID 
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3-1-2. Default Account 
 

What’s Account? 
The e-Parcel ID must belong to at least one account in which we charge for the data transmissions 

(uploading) through the e-Parcel service. 

 

On VCN-CommCenter 8.0, in the “User Configuration” pane, the “Default Account” box displays the 

current account information which the e-Parcel ID belongs to. 

(Default: Account in VCN-AX 5.0 when “Register ID Sharing” configured) 
*Regardless of Private ID and Sharing ID, if the e-Parcel ID or the account is limited by the maximum 

volume of data transmission for a delivery as contracted with us, the maximum value might be shown 
as “Parcel Size Limit: xx” in the “Default Account” box. If without limit a delivery, it is shown as “Parcel 
Size Limit: Unlimited”. 

 

In addition, when Send Dialog opens upon the “Create New” button on the VCN-CommCenter GUI, 

the “Account” box in Send Dialog displays the default account specified in the “User Configuration”. 

 

[VCN-CommCenter 8.0: “User Configuration” pane] 

 
 

 

【In the case Sharing ID belongs to multiple accounts】 

In the “User Configuration” pane, the “Default Account” box with pull-down menu displays all 

account information which the e-Parcel ID belongs to. 

On VCN-CommCenter 8.0 in ID Sharing Mode, if you change the default account to another, the 

change affects just current VCN-CommCenter 8.0 in ID Sharing Mode. This change 

doesn’t affect any other VCN-CommCenter 8.0 in ID Sharing Mode and VCN-AX 5.0. 

 

On the VCN-AX 5.0 Management Console, in the “Configuration” > “User Config” window, if you 

change the default account to another, the change affects just VCN-AX 5.0. This change 

doesn’t affect VCN-CommCenter 8.0 in ID Sharing Mode which already have been configured to 

“Register ID Sharing”. 
*However, after the change above, the new default account specified in VCN-AX 5.0 will be applied to 

VCN-CommCenter 8.0 which will be configured to “Register ID Sharing” later. 

 

[Default Account] 
Current account information 
which e-Parcel ID belongs to. 

*Parcel Size Limit a delivery 
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3-1-3. Data Storage Path 
On VCN-CommCenter 8.0, this setting in ID Sharing Mode differs functionally from 

Private Mode in some ways. When sending and receiving data on VCN-CommCenter 8.0 in ID 

Sharing Mode, the e-Parcel system applies the “Data Storage Path” specified in the “User Config” 

on VCN-AX 5.0 to proceed those processes for data delivery. 

 

Warning: Don't obtain any data directly from the folder specified as 
“Data storage path". Because this system folder is managed by the e-Parcel 
system. 

 

 

Data Storage Path in VCN-CommCenter 8.0 

On VCN-CommCenter 8.0 in ID Sharing Mode, the “Data Storage Path” specified in the “User 

Configuration” is used as the destination location in which the application temporally 

creates the system folder in order to copy the attached files when you open from inbox. This 

temporary system folder has been stored in the “Data Storage Path” during running the 

current VCN-CommCenter 8.0 in ID Sharing Mode. Whenever the application shut down 

(from the menu File > Exit), it will be deleted automatically. 
*Refer to P79 3-4. How to use ID Sharing function – 3-4-3. Open & Move (Save) files from Inbox 

 

On VCN-CommCenter 8.0, in the “User Configuration” pane, the “Data Storage Path” box displays 

as below with the default setting or the full path of a folder which you specified. (changeable) 

(Default for VCN-CommCenter 8.0/ C:¥e-Parcel¥VCN-CommCenter¥data) 
*On VCN-CommCenter 8.0 in ID Sharing Mode, if you change the data storage path, the change affects 

just current VCN-CommCenter 8.0 in ID Sharing Mode. This change doesn’t affect any other 
VCN-CommCenter 8.0 in ID Sharing Mode and VCN-AX 5.0.  

 
*In the case VCN-AX 5.0 and VCN-CommCenter 8.0 in ID Sharing Mode installed in same one computer 

(localhost), the “Data Storage Path” box in VCN-CommCenter 8.0 displays the full path of a folder 
specified in VCN-AX 5.0 with grayed-out effect. (unchangeable) 

 

[ VCN-CommCenter 8.0: “User Configuration” pane] 

 
 

 

 

 

 

[Data Storage Path] 
Location  

for temporary system folder 
on VCN-CommCenter 8.0 

in ID Sharing Mode 
*When sending and receiving, 
Data Storage Path specified in 

VCN-AX 5.0 is applied. 
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Data Storage Path in VCN-AX 5.0 

During use of the “ID Sharing” function, when sending and receiving data on VCN-A 5.0 

and on all of VCN-CommCenter 8.0 in ID Sharing Mode, the e-Parcel system applies the “Data 

Storage Path” specified in the “Configuration” > “User Config” on the VCN-AX 5.0 

Management Console to proceed those processes for data delivery. 

(Default for VCN-AX 5.0/ C:¥e-Parcel¥VCN-AX 5.0¥data) 
*Refer to P19 1. Preparations for e-Parcel VCN-AX 5.0 – Attention Users in VCN-AX 5.0 
*Refer to P79 3-4. How to use ID Sharing function – 3-4-3. Open & Move (Save) files from Inbox 

 

[VCN-AX 5.0 Management Console / Configuration > User Config] 

 

 

 

 

 

 

 

 

 

Caution: Please be advised that user of VCN-AX 5.0 ID Sharing Host PC should 

verify that there is enough disk space in the directory specified in the 

“Data Storage Path” of VCN-AX 5.0. Also, it is recommended to move (save) 

the received items being the delivery status of “Delivery Confirmed” or “Item 

Opened” from inbox which the Receive Automation function didn’t work to move to 

the folder predetermined in VCN-AX 5.0. 

 

 

User Config 

During “ID Sharing” 
VCN-AX 5.0 Host 

[User Config] 
Data Storage Path 

↓ 
This location is also applied to 
VCN-CommCenter 8.0 Clients 
when sending and receiving. 
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3-2. Option Configuration in VCN-CommCenter 8.0 

To open the “Option Config” dialog, on the VCN-CommCenter GUI, in the menu bar, click Tools > 

Option. 

 

 

 

 

On the “Option Config” dialog, you can customize some functions appropriately as necessary. In 

the case of using multiple e-Parcel ID on one VCN-CommCenter GUI, the changes in Option 

Configuration affect all -e-Parcel ID. 
* During use of the “ID Sharing” function, note that Polling Interval and Resend Settings configured to 

VCN-AX 5.0 are applied to VCN-CommCenter 8.0 in ID Sharing Mode. 

 

 

On VCN-CommCenter 8.0, some settings of Option Configuration in ID Sharing Mode 

are different from Private Mode. 

During use of the “ID Sharing” function, the details of difference in the settings of Option 

Configuration can be found from the next page of this manual. 

 

 

For your information, more details of Option Configuration in VCN-CommCenter 8.0 can be found in 

the section “Option Configuration” of the online manual listed in the site below. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

 

 

 

 

 

Option Config 

Sharing ID 
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3-2-1. General tab in Option Config 
On VCN-CommCenter 8.0, in the “Option Config” dialog, to change the settings as necessary, 

configure on the “General” tab which has been pre-set with the default value from the beginning. 

 

Polling Interval and Resend Settings in VCN-CommCenter 8.0 
On VCN-CommCenter 8.0, these settings in ID Sharing Mode differ from Private Mode 

in some ways. During use of the “ID Sharing” function, Polling Interval and Resend 

Settings configured to the “System Config” in VCN-AX 5.0 are applied to all of 

VCN-CommCenter 8.0 in ID Sharing Mode. Therefore, these values configured to VCN-AX 5.0 are 

shown in the setting boxes of the “Option Config” which are unchangeable with grayed-out effect 

on VCN-CommCenter 8.0 in ID Sharing Mode. 

 

[VCN-CommCenter 8.0 in ID Sharing Mode: Option Config “General” tab (default settings)] 

 

 

 

[Option Config: General] 
in ID Sharing Mode 

Settings with grayed-out 
(unchangeable) 

*The values configured to VCN-AX 5.0 
are applied. 

[e-Mail Notification, Automation] 
in ID Sharing Mode 

Settings with grayed-out 
(dysfunctional) 

*HotFolder & Automation functions in 
VCN-AX 5.0 are provided. 
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*When you set up both Private ID and Sharing ID to one VCN-CommCenter GUI, each ID in Private 
Mode and in ID Sharing Mode must work according to each value in Polling Interval and Resend 
Settings. 

 

Warning: On VCN-CommCenter 8.0, in the “Option Config” dialog, the “Resend 

Period” setting of “0” days in ID Sharing Mode would behave in the 

different way from Private Mode. 

[e-Parcel VCN-CommCenter 8.0: Resend Period] 

Sharing ID：☑Enable Resend (Yes) / 0 days → Unlimited (*without limit) 

Private ID：☑Enable Resend (Yes) / 0 days → 0 day (*disabled sometime today) 

 

 

Polling Interval and Resend Settings in VCN-AX 5.0 
If you wish to change Polling Interval and Resend Settings on VCN-CommCenter 8.0 in ID Sharing 

Mode, would you please firstly consult user of VCN-AX 5.0 ID Sharing Host PC or company's 

network administrator? To do this, on the VCN-AX 5.0 Management Console, in the “Configuration” 

> “System Config” window, change the settings of Polling Interval and Resend Settings, and then 

click the “Apply” button. 
*For VCN-AX 5.0 users, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” 

menu. Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

[VCN-AX 5.0 Management Console / Configuration > System Config (default settings)] 

 

 

 

 

 

 

 

 

Configuration 
> System Config 

During “ID Sharing” 
VCN-AX 5.0 Host 
[System Config] 

(default) 
Enable Resend: Yes 

Resend Period: 2 weeks 
Polling Interval: 5 minutes 

↓ 
These settings also applied to 
VCN-CommCenter 8.0 Clients. 
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3-2-2. e-Mail Notification tab in Option Config 
This configuration is disabled with grayed-out effect on VCN-CommCenter 8.0 in ID 

Sharing Mode. (Dysfunctional tab) 

If you wish the e-Mail Notification function in ID Sharing Mode, configure the Automation functions 

(HotFolder and Receive Automation) provided in VCN-AX 5.0. 

(Required: Configurations in VCN-AX 5.0 below) 

 

【VCN-AX 5.0 Management Console: in the “Configuration” menu】 

[User Config]: Configure to SMTP server settings, HotFolder & Automation Notice Name 

[HotFolder] [Automation] Config: Type “Notify Email To” in the entries for HotFolder & Automation 
*For VCN-AX 5.0 users, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” 

menu. Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

[VCN-CommCenter 8.0 in ID Sharing Mode: Option Config “e-Mail Notification” tab] 

 

 

[e-Mail Notification] 
in ID Sharing Mode 

Settings with grayed-out 
(dysfunctional) 

*HotFolder & Automation functions in 
VCN-AX 5.0 are provided. 
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3-2-3. Automation tab in Option Config 
This configuration is disabled with grayed-out effect on VCN-CommCenter 8.0 in ID 

Sharing Mode. (Dysfunctional tab) 

If you wish the Automation function in ID Sharing Mode, configure the Automation functions 

(HotFolder and Receive Automation) provided in VCN-AX 5.0. 

(Required: Configurations in VCN-AX 5.0 below) 

 

【VCN-AX 5.0 Management Console: in the “Configuration” menu】 

[System Config]: Create new folders within HotFolder Location & Automation Location. 

[HotFolder] [Automation] Config: Add new entries for HotFolder & Automation. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

[VCN-CommCenter 8.0 in ID Sharing Mode: Option Config “Automation” tab] 

 

 

[Automation] 
in ID Sharing Mode 

Settings with grayed-out 
(dysfunctional) 

*HotFolder & Automation functions in 
VCN-AX 5.0 are provided. 
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3-3. Address Book of VCN-CommCenter 8.0 and  

Records / License Count of VCN-AX 5.0 

 

On VCN-CommCenter 8.0, Address Book in ID Sharing Mode differs from one in Private 

Mode in some ways. Address Book is also shared during use of the “ID Sharing” 

function. Therefore, the same Address Book including address lists (All Addresses, Favorites), 

the created Group and the edited Template is displayed on all of VCN-CommCenter 8.0 in ID 

Sharing Mode. 

 

Furthermore, the “All Addresses” list of Address Book on VCN-CommCenter 8.0 in ID 

Sharing Mode would be interlocked with the “Recipient Records” on VCN-AX 5.0. So, it 

is recommended that user of VCN-AX 5.0 ID Sharing Host PC should manage appropriately 

“License Count” (Maximum number of Recipient Records) as contracted with us. On the 

VCN-AX 5.0 Management Console, in the “Authorization” > “Credential” and “Rcpt Records” 

window, you can confirm the current “Recipient Records” and “License Count”. 

 

Concerning Address Book of VCN-CommCenter 8.0 and Recipient Records / License Count of 

VCN-AX 5.0 in cooperation with each other, it can be found in the following pages of this manual. 

 

 

 

 

 

 

 

 



e-Parcel ID Sharing function Operation Guide EN                                             EP-PM-MN-0381 

Copyright© e-Parcel Corporation All rights reserved. 65 

 

3-3-1. Address Book in VCN-CommCenter 8.0 
To open the “Address Book”, click the “Address Book” button which has been enabled in color 

while Inbox or Outbox for the Sharing ID is displayed (selected) on the VCN-CommCenter GUI. 

 

On VCN-CommCenter  8.0, you can operate “Address Book” in ID Sharing Mode in the same way 

as in Private Mode. 

 

More details of Address Book in VCN-CommCenter 8.0 can be found in the section “Address Book” 

of the online manual listed in the site below. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

 

 

 

 

 

 

 

Change and Edit Address Book in VCN-CommCenter 8.0 

Address Book on VCN-CommCenter 8.0 in ID Sharing Mode ID is shared. Therefore, any 

changes in the address lists (All Addresses, Favorites), the created Group and the edited Template 

would affect all of VCN-CommCenter 8.0 in ID Sharing Mode. 
*Exception, when you sort the addresses by name in the “Address List” on the right pane of Address 

Book, this change affects just current VCN-CommCenter 8.0 in ID Sharing Mode.  
 
*Note that Group is not displayed with the default setting on Address Book in ID Sharing Mode. 

(As compared with Address Book in Private Mode, one Group is usually displayed with the default 
setting.) 
If you wish to create Groups on Address Book in ID Sharing Mode, on the left pane of Address Book, 
right-click “All Addresses” to open pop-up menu, click “Create New Group”. 

 

Address Book 

Sharing ID 
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Add new address to Address Book in VCN-CommCenter 8.0 
At the time of the following operations, the new address will be added to the address 

lists (All Addresses, Favorites) on Address Book in all of VCN-CommCenter 8.0 in ID Sharing Mode. 

・When an item is sent from Sharing ID to new e-Parcel ID  

・When an item from new e-Parcel ID is received by Sharing ID 

・When you add new e-Parcel ID by “New Address” of Address Book in VCN-CommCenter 8.0 

・When you add new e-Parcel ID by “Import List” menu of Address Book in VCN-CommCenter 8.0 

 

During use of the “ID Sharing” function, at the same time, in VCN-AX 5.0 ID Sharing Host PC, 

on the VCN-AX 5.0 Management Console, in the “Authorization” > “Rcpt Records” window, the 

new address will be listed additionally. Also, it will count up to the number of Recipient 

Records in the “Credential” window for every additional new address. 

 

[VCN-CommCenter 8.0: Address Book (All Addresses)] 

 

 

During “ID Sharing” 
VCN-CommCenter 8.0 Client 

[All Addresses] 
＝ 

VCN-AX 5.0 Host 
[Recipient Records] 
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Hide address from Address Book in VCN-CommCenter 8.0 
When you right-click the address listed on the right pane of Address Book, and then click 

“Hidden”, the existing address will be hidden from the address lists (All Addresses, 

Favorites) on Address Book in all of VCN-CommCenter 8.0 in ID Sharing Mode. 

 

During use of the “ID Sharing” function, at the same time, in VCN-AX 5.0 ID Sharing Host PC, 

on the VCN-AX 5.0 Management Console, in the “Authorization” > “Rcpt Records” window, the 

hidden address won’t be listed. (N.A.) Also, it will no longer count to the number of 

Recipient records in the “Credential” window for every hidden address. 

 

[VCN-CommCenter 8.0: Address Book] 

 
 

 

During “ID Sharing” 
VCN-CommCenter 8.0 Client 

Address [Hidden] 
＝ 

VCN-AX 5.0 Host 
Recipient Records [N.A.] 
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3-3-2. Recipient Records / License Count in VCN-AX 5.0 
To confirm “Recipient Records” and “License Count” in VCN-AX 5.0, on the VCN-AX 5.0 

Management Console, visit the “Authorization” > “Credential” and “Rcpt Records” window. 

 

Usually, in VCN-AX 5.0, when an item is sent to the e-Parcel ID specified as a new destination, 

this new recipient e-Parcel ID will be listed additionally in the “Rcpt Records” window. 

Also, it will count up this additional new e-Parcel ID to the number of Recipient Records in 

the “Credential” window. 

 

On the other hand, when you click [N.A.✖] button in the “Rcpt Records” window, this existing 

recipient e-Parcel ID will be hidden. Also, it will no longer count this hidden e-Parcel ID to the 

number of Recipient records in the “Credential” window. 

 

 

Recipient Records / License Count in “Credential” of VCN-AX 5.0 

As mentioned above, during use of the “ID Sharing” function, the “Recipient Records” on 

VCN-AX 5.0 would be interlocked with the “All Addresses” list of Address Book on 

VCN-CommCenter 8.0. Therefore, it is recommended that user of VCN-AX 5.0 ID Sharing Host 

PC should manage appropriately “License Count” (Maximum number of Recipient Records) 

as contracted with us. 

 

[VCN-AX 5.0 Management Console / Authorization > Credential] 

 

 

 

 

 

 

 

[Credential] 
During “ID Sharing” 

VCN-AX 5.0 Host 
[Recipient Records] count 

＝ 
VCN-CommCenter 8.0 Client 

[All Addresses] count 
Note that the number of Recipient Records 

could not exceed License Count. 
Confirm License Count 

as contracted! 

Authorization 
> Credential 
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Add and hide “Rcpt Records” of VCN-AX 5.0 

At the same time the new address is added to Address Book on VCN-CommCenter 8.0 in 

ID Sharing Mode, in VCN-AX 5.0 ID Sharing Host PC, on the VCN-AX 5.0 Management 

Console, in the “Authorization” > “Rcpt Records” window, the new address will be listed 

additionally. Also, it will count up to the number of Recipient Records in the “Credential” 

window for every additional new address. 

 

At the same time the existing address is hidden from Address Book on 

VCN-CommCenter 8.0 in ID Sharing Mode, in VCN-AX 5.0 ID Sharing Host PC, on the 

VCN-AX 5.0 Management Console, in the “Authorization” > “Rcpt Records” window, the hidden 

address won’t be listed. (N.A.) Also, it will no longer count to the number of Recipient 

records in the “Credential” window for every hidden address. 

 

[VCN-AX 5.0 Management Console / Authorization > Rcpt Records] 

 

 

 

 

 

 

 

 
*Attention: If the number of Recipient Records has exceeded License Count, you can no longer send 

items to new recipient e-Parcel ID due to “License Error” detected. To promptly recover this situation, 
on the VCN-AX 5.0 Management Console, in the “Authorization” > “Rcpt Records” window, hide (N.A.) 
unnecessary e-Parcel ID from the existing recipient records. 

*For any inquiry or request about the contracted “License Count”, consult your company's system 
administrator or contact our sales representatives (Email: sales@e-parcel.co.jp). 

*For VCN-AX 5.0 users, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” 
menu. Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

[Rcpt Records] 
During “ID Sharing” 

VCN-AX 5.0 Host 
[Recipient Records] 

＝ 
VCN-CommCenter 8.0 Client 

[All Addresses] 

During “ID Sharing” 
VCN-AX 5.0 Host 

Recipient Records [N.A.✖] 
＝ 

VCN-CommCenter 8.0 Client 
Address [Hidden] 

 

Rcpt Records 
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3-4. How to use ID Sharing function 

During use of the “ID Sharing” function, to send and receive data on VCN-AX 5.0 and 

VCN-CommCenter 8.0 in ID Sharing Mode, operate in the same way as Private Mode as well. 
 

 

About sending and receiving data 
 

In the e-Parcel VCN-AX 5.0 ID Sharing Host PC: 

To send and receive files and folders, configure the Automation functions (HotFolder, Receive 

Automation) to work as usual. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-AX 5.0 Quick Guide” listed in the webpage. 

 

 

In the e-Parcel VCN-CommCenter 8.0 ID Sharing Client PC: 

To send files and folders after “Register ID Sharing” configured, create new using Send Dialog as 

usual. The brief explanation of Send Dialog in VCN-CommCenter 8.0 can be found from the next 

page of this manual. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 
*If you wish Automation and e-Mail Notification in VCN-CommCenter 8.0 ID Sharing Clients, the 

Automation functions (HotFolder, Receive Automation) in VCN-AX 5.0 ID Sharing Host are provided. 

 

 

During use of the “ID Sharing” function, when sending and receiving data, the “Data 

Storage Path” specified in the “User Config” on VCN-AX 5.0 is applied to all of 

VCN-CommCenter in ID Sharing Mode to proceed those processes for data delivery. 

(Default: C:¥e-Parcel¥VCN-AX 5.0¥data) 
*Don't obtain any data directly from the folder specified as "Data storage path". Because this system 

folder is managed by the e-Parcel system. Also, verify that there is enough disk space. 
*Refer to P19 1. Preparations for e-Parcel VCN-AX 5.0 – Attention Users in VCN-AX 5.0 
*Refer to P57 3-1. User Configuration in VCN-CommCenter 8.0 – 3-1-3. Data Storage Path 
*Refer to P79 3-4. How to use ID Sharing function – 3-4-3. Open & Move (Save) files from Inbox 

 

 



e-Parcel ID Sharing function Operation Guide EN                                             EP-PM-MN-0381 

Copyright© e-Parcel Corporation All rights reserved. 71 

 

About outbox and inbox view 
 

During use of the “ID Sharing” function, the histories recorded in outbox and inbox can 

be shared with VCN-AX 5.0 and all of VCN-CommCenter 8.0 in ID sharing Mode. The “Outbox” 

and “Inbox” view would display same history records as well both on the VCN-AX 5.0 

Management Console and on VCN-CommCenter 8.0 in ID sharing Mode. 
*Exception, if you change the Display Period by Created Date in “Outbox” and “Inbox” on the VCN-AX 

5.0 Management Console (Default: Today), this change doesn’t affect any of VCN-CommCenter 8.0 in 
ID Sharing Mode. (As compared with VCN-CommCenter 8.0, all history records always are displayed in 
“Outbox” and “Inbox” without any setting.) 

 

 

In addition, the Polling Interval configured to the “System Config” in VCN-AX 5.0 is 

applied to all of VCN-CommCenter in ID Sharing Mode. That is auto-polling periodically to the 

e-Parcel server for checking external events such as tracking the latest delivery status and detecting 

the existence of unreceived items similarly as Private Mode. (Default: 5 minutes interval) 
*Refer to P60 3-2. Option Configuration in VCN-CommCenter 8.0 – 3-2-1. General tab in Option Config 
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3-4-1. Sending and Outbox 
The “ID Sharing” function requires starting the service for VCN-AX 5.0 and being 

online. 

On VCN-CommCenter 8.0 ID in ID Sharing Mode, to send files and folders, take the operating 

procedure below similarly as Private Mode. 

 

More details of sending items in VCN-CommCenter 8.0 can be found in the section “Sending” of the 

online manual listed in the site below. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 
*If you wish Automation and e-Mail Notification in ID Sharing Mode, the “HotFolder” function in VCN-AX 

5.0 is provided for auto-sending. 

 

 

【How to send new item in VCN-CommCenter 8.0】 

①To open the Send Dialog, click the “Create New” button which has been enabled in color 

while Inbox or Outbox for the Sharing ID is displayed (selected) on the VCN-CommCenter GUI. 

 

[VCN-CommCenter 8.0 in ID Sharing Mode] 

 

 

 

 

 

 

 

 

①Create New 

Sharing ID 
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②Confirm the Sharing ID shown as Sender in the bottom-left on the Send Dialog. 

 
*The “Message decoration with rich text format” function has been provided since e-Parcel VCN-CommCenter 

8.0.8023 (Released in March 2022). VCN-CommCenter 8.0 ID Sharing Client interlocked with e-Parcel VCN-AX 
5.0.5013 (Released in August 2022) or later supports this function. When the setting “Sending message 
decoration (disabled by default)” is enabled, the message decoration tool bar is shown additionally on upper of 
the message box in Send dialog. For more details about “Message decoration” function, refer to the “e-Parcel 
VCN-CommCenter 8.0 Users Manual”. 

 
 

 

 

 

 

 

 

 

[Sender] 
②Confirm the Sharing ID shown! 
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③Input the recipient (To*), subject, message and attach files/folders* on the Send Dialog. When 

you are finished, click “Send” button. 
*Attention: When both “TO” and “Item (files and/or folders attached)” boxes are entered on the Send 

Dialog, the “Send” button will be enabled (in color). 

 

 

Upon sending operation (click “Send” button), the application is compressing and archiving new item. 

When this preparation processing completed, the Send Dialog will close automatically and the 

uploading processes will start. And then, the outbox view on the VCN-CommCenter GUI can 

automatically be refreshed to add new entry.  

(For your information, just before starting to upload, the item must be encrypted automatically.) 

 

Warning: After sending operation (click “Send” button), don’t move or 

delete the attached files/folders from the original stored location in 

your computer until the Send Dialog will close automatically (until 

uploading processes will start). Because it is possible to be the cause of the 

trouble such as the uploading processes may not start normally. 

 

[To] *Required 
Input 

e-Parcel ID! 

[Item] *Required 
Attach 

files and/or folders! 

③Send! 
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④Check the sending item being the delivery status of “Waiting Download” in outbox when 

uploading processes are completed. For mor details, double-click an item in outbox to view its 

description. The “Parcel Detail” dialog will open. When the recipient starts downloading, it will 

display the recipient’s delivery progress status additionally. (Tracking) 
 

Regarding the tracking, the application is auto-polling periodically to the e-Parcel server at 

regular intervals for checking the latest delivery status. Or, the “Reload” button is also 

provided for prompt polling. 
*During use of the “ID Sharing” function, note that Polling Interval configured to VCN-AX 5.0 is applied 

to VCN-CommCenter 8.0 in ID Sharing Mode. (Default: 5 minutes interval) 

 

When downloading processes are confirmed successfully at recipient side, the delivery status will 

be updated to “Delivery Confirmed”. 

(For your information, just before delivery confirmed, the item must be decrypted automatically.) 
*In the case of recipients who use the e-Parcel Web Browser client (e-Parcel VCN-Web), the last delivery 

status will be “Download Complete”. 

 

[VCN-CommCenter 8.0 ID in ID Sharing Mode / Outbox] 

 

 

[Outbox] 
④Status: Waiting Download 

*Uploading processes are completed! Sharing ID 
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【VCN-AX 5.0 ID Sharing Host PC: Outbox】 

During use of the “ID Sharing” function, the histories recorded in outbox and inbox 

would be shared. Therefore, the outbox view on both the VCN-AX 5.0 Management Console and 

all of VCN-CommCenter 8.0 in ID Sharing Mode can automatically be refreshed to add new entry. 
*Refer to P81 3-4. How to use ID Sharing function – 3-4-4. VCN-AX 5.0 ID Sharing Audit function 

 

[VCN-AX 5.0 Management Console / Outbox] 

 

 

 

 

 

[VCN-AX 5.0] 
Outbox view is 

shared! 
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3-4-2. Receiving and Inbox 
The “ID Sharing” function requires starting the service for VCN-AX 5.0 and being 

online. 

 

VCN-CommCenter 8.0 ID in ID Sharing Mode automatically starts receiving (downloading) 

items without any operation by recipient similarly as Private Mode. 

Regarding receiving items, the application is auto-polling periodically to the e-Parcel server at 

regular intervals for detecting the existence of unreceived items. 
*During use of the “ID Sharing” function, note that Polling Interval configured to VCN-AX 5.0 is applied 

to VCN-CommCenter 8.0 in ID Sharing Mode. (Default: 5 minutes interval) 
*If you wish Automation and e-Mail Notification in ID Sharing Mode, the Receive “Automation” function 

in VCN-AX 5.0 is provided for auto-receiving. 

 

Or, the “Reload” button on VCN-CommCenter 8.0 and in outbox/inbox on the VCN-AX 5.0 

Management Console are also provided for prompt polling. 

 

[VCN-CommCenter 8.0 ID in ID Sharing Mode / Inbox] 

 

 

 

 

 

 
*The “Message decoration with rich text format” function has been provided since e-Parcel VCN-CommCenter 

8.0.8023 (Released in March 2022). VCN-CommCenter 8.0 ID Sharing Client interlocked with e-Parcel VCN-AX 
5.0.5013 (Released in August 2022) or later supports this function. The inbox “Parcel Detail” dialog will display 
the message in either simple or rich text format according to the text format of message at the sender side. 

 

 

[Inbox] 
Status: Delivery Confirmed 

*Downloading processes are confirmed 
↓ 

Double-click to open, 
then Move (Save) File! 

Sharing ID 
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【VCN-AX 5.0 ID Sharing Host PC: Inbox】 

During use of the “ID Sharing” function, the histories recorded in outbox and inbox 

would be shared. Therefore, the inbox view on both the VCN-AX 5.0 Management Console and all 

of VCN-CommCenter 8.0 in ID Sharing Mode can automatically be refreshed when Sharing ID starts 

receiving new items. 
*Refer to P81 3-4. How to use ID Sharing function – 3-4-4. VCN-AX 5.0 ID Sharing Audit function 

 

[VCN-AX 5.0 Management Console / Inbox] 

 

 

 

 

 

 

 

 

[VCN-AX 5.0] 
Inbox view is 

shared! 
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3-4-3. Open & Move (Save) files from Inbox 
When downloading processes are confirmed successfully, the delivery status will be updated to 

“Delivery Confirmed” in inbox on VCN-CommCenter 8.0. After that, you can open the 

received items and move (save) the attached files/folders. 

 

If Receive Automation function has been configured to work in VCN-AX 5.0, upon satisfaction of the 

conditions predetermined in an entry, the attached files/folders will automatically be moved to the 

destination folder specified as Receive Automation folder. At this time, the delivery status will be 

updated to “Item Moved”. 

 

Open File (Save as) 
When you double-click an item being the delivery status of “Delivery Confirmed” in inbox to 

view its description on VCN-CommCenter 8.0, the “Parcel Detail” dialog will open, and then the 

delivery status will be updated to “Item Opened”. 

 

On VCN-CommCenter 8.0, the following operation in ID Sharing Mode differs 

functionally from Private Mode in some ways. During use of the “ID Sharing” function, 

when you double-click the attached file on the “Parcel Detail” dialog in inbox to open, the 

application will temporally copy a file to the system folder “Data Storage Path” specified in 

the current VCN-CommCenter 8.0 in ID Sharing Mode, and then open this temporary file. 

Therefore, even though you edit and save this temporary file, that doesn’t overwrite the original 

attached file in the system folder “Data Storage Path” specified in VCN-AX 5.0. Note that the 

temporary file has been stored during running the current VCN-CommCenter 8.0 in ID 

Sharing Mode. it would be deleted automatically whenever shut down (from the menu 

File > Exit). 

 

If you need the temporary file opened currently, “Save as” with a new name in the directory 

where is easy to find. OR, operate as below to move (save) the original attachments. 
*Don't obtain any data directly from the folder specified as "Data storage path". Because this system 

folder is managed by the e-Parcel system. Also, verify that there is enough disk space. 
*Refer to P57 3-1. User Configuration in VCN-CommCenter 8.0 – 3-1-3. Data Storage Path 

 

Move File (Save original file) 
On VCN-CommCenter 8.0, when you double-click an item being the delivery status of 

“Delivery Confirmed” or “Item Opened” in inbox to view its description, the “Parcel Detail” 

dialog will open. To move (save) the original attached files/folders from the system folder 

“Data Storage Path” specified in VCN-AX 5.0 to the directory where you select, click the “Move 

File” button enabled in color in the same way as Private Mode. At this time, the delivery status will 

be updated to “Item Moved”. Note that the “Move File” operation is effective only once. 
*Refer to P19 1. Preparations for e-Parcel VCN-AX 5.0 – Attention Users in VCN-AX 5.0 
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[VCN-CommCenter 8.0 ID in ID Sharing Mode / Inbox Parcel Detail] 

 
 

 

More details of receiving items in VCN-CommCenter 8.0 can be found in the section “Receiving” of 

the online manual listed in the site below. 
*For more details, visit Online Manual URL: https://www.e-parcel.ne.jp/ and click “Users Manual” menu. 

Please refer to the “e-Parcel VCN-CommCenter 8.0 Users Manual” listed in the webpage. 

 

 

Warning: Downloading data must be made within 31 days from the 

date of item sent (item created). After expired, the unreceived items will 

automatically be deleted from the e-Parcel server. Therefore, you can NOT 

download the expired items any longer. Also, the delivery statuses of the 

expired items will be no longer updated. 

 

Move File (Save) 
Click when this button is enabled in color. 

↓ 
Move (Save) the original attachments! 

*You can move files only once. 

Received item box 
Attachments icon shown in color 

Open file: OK 
Move file: OK 

*Note: After delivery confirmed, attachments icons 
will appear on Inbox Parcel Detail. 

*The colored icons: You have not moved files yet. 
*Grayed-out icons: You have already moved files. 
*Once items moved, you cannot open the attached 

files/folders from inbox. 

Open File 
[ID Sharing Mode] 

To open temporary file, 
double-click  

the colored icon! 
↓ 

Save as! 



e-Parcel ID Sharing function Operation Guide EN                                             EP-PM-MN-0381 

Copyright© e-Parcel Corporation All rights reserved. 81 

 

3-4-4. VCN-AX 5.0 ID Sharing Audit function 
For user of VCN-AX 5.0 ID Sharing Host PC, the “ID Sharing Audit function” is provided. 

 

According to the ID Sharing Audit function, user of VCN-AX 5.0 ID Sharing Host PC can verify the 

VCN-CommCenter 8.0 ID Sharing client PC in which a new item was sent, an inbox 

item was opened or moved. On the VCN-AX 5.0 Management Console, in the “Outbox” 

and “Inbox” view > the “Outbox Item” and “Inbox Item” detail window, the “Status” field will be a 

link to Show Audit in ID Sharing Mode. 
*The “ID Sharing Audit function” has been provided since e-Parcel VCN-AX 5.0.5012 (Released in 

August 1, 2021). This new function additionally shows the events by ID Sharing client PC to audit. 
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【Outbox】 To Show Audit, open “Outbox Item”, click “Status”. 
When a new item created is sent by VCN-CommCenter 8.0 ID in ID Sharing Mode, the 

history recorded in outbox would be shared. Therefore, the outbox view on the VCN-AX 5.0 

Management Console can automatically be refreshed to add new entry. 

 

①In the VCN-AX 5.0 “Outbox” view, select an item above, click the “Status” (displayed in blue) 

field. The new window opens to show the “Outbox Item” detail. 

 

②On the “Outbox Item” detail window, click the “Status” (displayed in blue) field to Show 

Audit. 
*For only items sent, opened or moved by VCN-CommCenter 8.0 in ID Sharing Mode, the Status field 

will be a link to Show Audit. 
*But, for items resent by VCN-CommCenter 8.0 in ID Sharing Mode, the Status field won’t show audit. 

 

[VCN-AX 5.0 Management Console / Outbox > Outbox Item] 

 

 

 

Outbox 
[Outbox Item detail] 

To show audit, 
click Status 

(displayed in blue). 
*For only items sent, opened or moved 

by VCN-CommCenter 8.0 
in ID Sharing Mode, 

the Status field will be a link 
to Show Audit. 
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③Upon click the “Status” (displayed in blue) field on the “Outbox Item” detail window to Show 

Audit, it additionally shows information about the VCN-CommCenter 8.0 ID Sharing 

client PC in which an item was sent. 
 

・Date Executed & Status: (Local Time) 

“Waiting Upload”: Date & time when VCN-AX 5.0 ID Sharing Host PC was requested to send 

a new item from VCN-CommCenter 8.0 ID Sharing client PC. 
*Then, the sending processes will start for a new item in VCN-AX 5.0 ID Sharing Host PC. 

“Item Opened”: Date & time when an inbox item was opened in VCN-CommCenter 8.0 ID 

Sharing client PC. (To open the “Inbox Item” detail window.) 

“Item Moved”: Date & time when the files/folders attached to an inbox item were moved 

(saved) in VCN-CommCenter 8.0 ID Sharing client PC. 
 
・Host Name: Name of VCN-CommCenter 8.0 ID Sharing client PC executed 

・IP Address: IP address of VCN-CommCenter 8.0 ID Sharing client PC executed 

 

[VCN-AX 5.0 Management Console / Outbox > Outbox Item > Show Audit] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To Close Audit, on the “Outbox Item” detail window, click again the “Status” (displayed in blue) 

field to return. 

 

TEST-PC-1 123.44.77.88 

Audit trail 
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【Inbox】 To Show Audit, open “Inbox Item”, click “Status”. 
When an inbox item was opened by double-click (To open the “Inbox Item” detail 

window) or the files/folders attached to an inbox item were moved (saved) by 

VCN-CommCenter 8.0 ID in ID Sharing Mode, the history recorded in inbox would be shared. 

Therefore, the inbox view on the VCN-AX 5.0 Management Console can automatically be refreshed 

to update the delivery status. 

 

①In the VCN-AX 5.0 “Inbox” view, select an item above, click the “Status” (displayed in blue) 

field. The new window opens to show the “Inbox Item” detail. 

 

②On the “Inbox Item” detail window, click the “Status” (displayed in blue) field to Show 

Audit. 
*For only items sent, opened or moved by VCN-CommCenter 8.0 in ID Sharing Mode, the Status field 

will be a link to Show Audit. 
*But, for items resent by VCN-CommCenter 8.0 in ID Sharing Mode, the Status field won’t show audit. 

 

[VCN-AX 5.0 Management Console / Inbox > Inbox Item] 

 

 

Inbox 
[Inbox Item detail] 

To show audit, 
click Status 

(displayed in blue). 
*For only items sent, opened or moved 

by VCN-CommCenter 8.0 
in ID Sharing Mode, 

the Status field will be a link 
to Show Audit. 
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③Upon click the “Status” (displayed in blue) field on the “Inbox Item” detail window to Show Audit, 

it additionally shows information about the VCN-CommCenter 8.0 ID Sharing client 

PC in which an item was opened or moved. 
 

・Date Executed & Status: (Local Time) 

“Waiting Upload”: Date & time when VCN-AX 5.0 ID Sharing Host PC was requested to send 

a new item from VCN-CommCenter 8.0 ID Sharing client PC. 
*Then, the sending processes will start for a new item in VCN-AX 5.0 ID Sharing Host PC. 

“Item Opened”: Date & time when an inbox item was opened in VCN-CommCenter 8.0 ID 

Sharing client PC. (To open the “Inbox Item” detail window.) 

“Item Moved”: Date & time when the files/folders attached to an inbox item were moved 

(saved) in VCN-CommCenter 8.0 ID Sharing client PC. 
 
・Host Name: Name of VCN-CommCenter 8.0 ID Sharing client PC executed 

・IP Address: IP address of VCN-CommCenter 8.0 ID Sharing client PC executed 

 

[VCN-AX 5.0 Management Console / Inbox > Inbox Item > Show Audit] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To Close Audit, on the “Inbox Item” detail window, click again the “Status” (displayed in blue) 

field to return. 

EP-TEST-64 
123.0.0.1 
123.44.99.11 

PC-EP-ABC-123 
123.0.0.1 PC-EP-ABC-123 

Audit trail 
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４．Delivery Status 

Delivery Status List (e-Parcel VCN-AX 5.0) 

 

Code Delivery Status Outbox Inbox 

0 （Nothing) ○ ○ 

10 Initializing ○  

20 Initializing ○  

30 Waiting Upload ○  

40 Uploading ○  

50 Upload Complete ○  

55 Waiting Permission ○  

60 Waiting Download *  

80 Waiting Download ○ ○ 

90 Upload Interrupted ○  

100 Waiting Download ○ ○ 

110 Downloading ○ ○ 

120 Download Complete ○ ○ 

125 Confirming Delivery  ○ 

130 Delivery Confirmed ○ ○ 

190 Request Error ○ ○ 

200 Item Opened ○ ○ 

210 Item Moved ○ ○ 

290 Cancel Requested ○  

300 Canceling ○ ○ 

310 Cancelled ○  

320 Upload Error ○  

400 Confirming Status ○ ○ 

410 Delivery Denied ○  

420 Download Aborted ○ ○ 

430 Item Deleted ○ * 

440 Delivery Closed *  

500 Download Error ○ ○ 

510 Unknown Recipient ○  

520 No Privilege ○  

[*] mark delivery statuses are used by only the e-parcel system. 

４ 
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Delivery Status List (e-Parcel VCN-CommCenter 8.0) 

 

Code Delivery Status Outbox Inbox 

10 Initializing ○  

20 
Initializing ○  

Encrypting xx % ○  

30 Waiting Upload ○  

40 
Upload Start ○  

Uploading xx % ○  

50 Upload Complete ○  

55 Waiting Approval ○  

60 Waiting Download *  

80 Waiting Download ○ ○ 

90 Upload Interrupted ○  

100 Waiting Download ○ ○ 

110 
Download Start ○ ○ 

Downloading xx %  ○ 

120 
Download Complete ○ ○ 

Decrypting xx %  ○ 

125 
Extracting xx %  ○ 

Delivery Verifying  ○ 

130 Delivery Confirmed ○ ○ 

190 Request Error ○ ○ 

200 Item Opened ○ ○ 

210 Item Moved ○ ○ 

290 Cancel Requested ○  

300 Canceling ○ ○ 

310 Cancelled ○  

320 Upload Error ○  

410 Delivery Denied ○  

420 Download Aborted ○ ○ 

430 Item Deleted ○ * 

440 Delivery Expired *  

500 Delivery Error ○ ○ 

510 Unknown Recipient ○  
※[*] mark delivery status are used by only the e-parcel system. 
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